# AutoCAD 2010 Basics

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>INTRODUCTION</td>
<td>1</td>
</tr>
<tr>
<td>Document Conventions</td>
<td>1</td>
</tr>
<tr>
<td>BEGINNING AUTOCAD</td>
<td>2</td>
</tr>
<tr>
<td>Using the Start Button to Launch Autocad</td>
<td>2</td>
</tr>
<tr>
<td>Using a Shortcut to Launch Autocad</td>
<td>2</td>
</tr>
<tr>
<td>AUTOCAD USER INTERFACE</td>
<td>3</td>
</tr>
<tr>
<td>Choosing Commands</td>
<td>4</td>
</tr>
<tr>
<td>Using the Keyboard</td>
<td>4</td>
</tr>
<tr>
<td>Selecting from a Ribbon Panel</td>
<td>4</td>
</tr>
<tr>
<td>Choosing from a Toolbar</td>
<td>5</td>
</tr>
<tr>
<td>Using Menu Search to Find Commands</td>
<td>6</td>
</tr>
<tr>
<td>Using Help</td>
<td>7</td>
</tr>
<tr>
<td>WINDOWS FILES AND FOLDERS</td>
<td>8</td>
</tr>
<tr>
<td>Opening Files and Folders</td>
<td>8</td>
</tr>
<tr>
<td>Renaming Files and Folders</td>
<td>8</td>
</tr>
<tr>
<td>Copying and Moving Files and Folders</td>
<td>8</td>
</tr>
<tr>
<td>Deleting Files and Folders</td>
<td>8</td>
</tr>
<tr>
<td>Switching Between Programs</td>
<td>9</td>
</tr>
<tr>
<td>Saving Documents</td>
<td>9</td>
</tr>
<tr>
<td>Manipulating Windows in Windows</td>
<td>9</td>
</tr>
<tr>
<td>Opening a Drawing</td>
<td>10</td>
</tr>
<tr>
<td>Closing a Drawing or Exiting Autocad</td>
<td>11</td>
</tr>
<tr>
<td>Beginning a New Drawing</td>
<td>11</td>
</tr>
<tr>
<td>Displaying Areas of a Drawing</td>
<td>12</td>
</tr>
<tr>
<td>Viewing the Entire Drawing</td>
<td>12</td>
</tr>
<tr>
<td>Enlarging or Reducing the Image</td>
<td>12</td>
</tr>
<tr>
<td>Viewing an Adjacent Area</td>
<td>12</td>
</tr>
<tr>
<td>Selecting Objects</td>
<td>12</td>
</tr>
<tr>
<td>Selecting Objects One at a Time</td>
<td>13</td>
</tr>
<tr>
<td>Removing Selected Objects</td>
<td>13</td>
</tr>
<tr>
<td>Selecting With a Window</td>
<td>13</td>
</tr>
<tr>
<td>Selecting With a Crossing</td>
<td>13</td>
</tr>
<tr>
<td>Erasing Objects</td>
<td>14</td>
</tr>
<tr>
<td>Using Right-Click Menus</td>
<td>14</td>
</tr>
<tr>
<td>Picking Points</td>
<td>15</td>
</tr>
<tr>
<td>Left-Click</td>
<td>15</td>
</tr>
<tr>
<td>Drawing a Line</td>
<td>15</td>
</tr>
<tr>
<td>Drawing a Series of Connected Lines</td>
<td>15</td>
</tr>
<tr>
<td>Undoing a Line Segment</td>
<td>15</td>
</tr>
<tr>
<td>Closing a Line Sequence</td>
<td>16</td>
</tr>
<tr>
<td>POLAR TRACKING</td>
<td>16</td>
</tr>
<tr>
<td>Dynamic Input Entry</td>
<td>18</td>
</tr>
<tr>
<td>Dynamic Input to Draw Lines</td>
<td>19</td>
</tr>
</tbody>
</table>

AutoCAD 2010 Basics.docx

Copyright (C) CCAD inc. July 8, 2010
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drawing a line from endpoint to endpoint</td>
<td>22</td>
</tr>
<tr>
<td>Drawing a line from midpoint to midpoint</td>
<td>22</td>
</tr>
<tr>
<td>Getting distances</td>
<td>22</td>
</tr>
<tr>
<td>Formatting numbers</td>
<td>23</td>
</tr>
<tr>
<td>Drawing a circle</td>
<td>24</td>
</tr>
<tr>
<td>Coordinates</td>
<td>26</td>
</tr>
<tr>
<td>Drawing a rectangle</td>
<td>28</td>
</tr>
<tr>
<td>Drawing a polygon</td>
<td>28</td>
</tr>
<tr>
<td>Aligning points with object snap tracking</td>
<td>29</td>
</tr>
<tr>
<td>Locating points near known locations – from</td>
<td>31</td>
</tr>
<tr>
<td>Moving objects</td>
<td>31</td>
</tr>
<tr>
<td>Copying objects</td>
<td>32</td>
</tr>
<tr>
<td>Offset objects</td>
<td>32</td>
</tr>
<tr>
<td>Breaking objects</td>
<td>33</td>
</tr>
<tr>
<td>Joining objects</td>
<td>33</td>
</tr>
<tr>
<td>Adding fillets</td>
<td>34</td>
</tr>
<tr>
<td>Adding chamfers</td>
<td>34</td>
</tr>
<tr>
<td>Using the properties palette</td>
<td>34</td>
</tr>
</tbody>
</table>

AutoCAD 2010 Basics.docx Copyright (C) CCAD inc. July 8, 2010
LINEAR DIMENSIONS ............................................................................................................................................................................ 55
  DIMENSION BASICS ........................................................................................................................................................................... 55
  PARTS OF A LINEAR DIMENSION .......................................................................................................................................................... 55
  CREATING A LINEAR DIMENSION ......................................................................................................................................................... 56
  MODIFYING A LINEAR DIMENSION ......................................................................................................................................................... 56
RADIUS DIMENSIONS ............................................................................................................................................................................ 57
  DIMENSION BASICS ........................................................................................................................................................................... 57
  PARTS OF A RADIUS DIMENSION .......................................................................................................................................................... 57
  CREATING A RADIUS DIMENSION ......................................................................................................................................................... 57
  MODIFYING A RADIUS DIMENSION ......................................................................................................................................................... 58
DIAMETER DIMENSIONS ............................................................................................................................................................................ 58
  DIMENSION BASICS ........................................................................................................................................................................... 58
  PARTS OF A DIAMETER DIMENSION ....................................................................................................................................................... 58
  CREATING A DIAMETER DIMENSION ....................................................................................................................................................... 59
  MODIFYING A DIAMETER DIMENSION ....................................................................................................................................................... 59
CENTER MARKS ..................................................................................................................................................................................... 60
  CREATING CENTER MARKS ...................................................................................................................................................................... 60
  FORMATTING CENTER MARKS ................................................................................................................................................................. 60
ANGULAR DIMENSIONS ............................................................................................................................................................................ 61
  CREATING AN ANGULAR DIMENSION ..................................................................................................................................................... 61
  MODIFYING AN ANGULAR DIMENSION ..................................................................................................................................................... 61
CONTROLLING NUMBERS IN DIMENSIONS .................................................................................................................................................. 62
  GLOBAL PRIMARY UNITS CHANGES ...................................................................................................................................................... 62
  OBJECT SPECIFIC PRIMARY UNITS CHANGES ........................................................................................................................................ 63
USING LEADERS ..................................................................................................................................................................................... 64
  ANNOTATION ............................................................................................................................................................................................ 64
  FORMAT ........................................................................................................................................................................................................... 64
USING QLEADERS .................................................................................................................................................................................. 65
  CREATING A LEADER WITH MTEXT .................................................................................................................................................... 65
  MANAGING THE LEADER AND ARROW PROPERTIES ................................................................................................................................ 65
  CONTROLLING THE MULTI-LINE TEXT ATTACHMENT .................................................................................................................................. 66
USING MULTILEADER ........................................................................................................................................................................... 66
THE TRIM AND EXTEND COMMANDS .................................................................................................................................................. 67
  TRIMMING .................................................................................................................................................................................................. 67
  EXTENDING .................................................................................................................................................................................................. 67
  SELECTION OPTIONS ................................................................................................................................................................................... 67
STRETCHING OBJECTS ........................................................................................................................................................................... 68
STRETCHING A RECTANGLE TO THE RIGHT ........................................................................................................................................... 69
STRETCHING A RECTANGLE TO THE LEFT ............................................................................................................................................... 70
STRETCHING A FIGURE WITH ISLANDS .................................................................................................................................................... 71
MIRRORING OBJECTS ........................................................................................................................................................................... 72
ARRAYING OBJECTS ................................................................................................................................................................................ 72
  CORNERSTONE OBJECTS ......................................................................................................................................................................... 73
  RECTANGULAR ARRAYS ........................................................................................................................................................................... 73
  POLAR ARRAYS .................................................................................................................................................................................................. 73
SCALING OBJECTS ................................................................................................................................................................................. 74
Introduction

AutoCAD is a Computer Aided Drafting software package that allows architects, engineers, surveyors, designers and drafters to create technical drawings to build and manufacture everything from microprocessors to aircraft carriers.

Many industries require a high level of technical drawing accuracy and AutoCAD provides this necessary feature. For example, all numeric values are stored in the drawing database with 14 digits of accuracy. While many applications do not require this level of precision, AutoCAD still manages data very accurately. To best function in this environment new AutoCAD users should have a basic understanding of standard drafting practices and pretty good math skills.

People often think of AutoCAD as an application that is geared toward creating architectural drawings. Others believe it intended for documenting machined parts. It is neither. For the most part, AutoCAD does not contain industry specific tools. You might have a saw, drill, hammer, wrench and screw driver in your workshop. You could build a piece of furniture or put an addition on your house. You might also change the spark plugs in your car using some of the very same tools. The commands in AutoCAD are just like those tools. Most of the commands can be used to draw anything.

One of the aspects of AutoCAD that makes it so popular is that developers can create industry specific add-on applications for use with AutoCAD. There are hundreds of libraries available for typical items like doors and windows, nuts and bolts, electrical symbols, and so on. Other add-ons are more extensive, like calculating and drawing piping based on required equipment loads. These generally employ one of the programming languages supported by AutoCAD (but not AutoCAD LT).

Whether you are planning to make 2D or 3D drawings with AutoCAD, you can think of a drawing as an electronic model of a design. Designs should be created in actual world units (life size or “one to one”) to allow measurements to be taken. Drawing in life size units also lets you see how components fit together before items are constructed or manufactured. Some technical documents are more representative and are not bound by life size units. Block diagrams and schematics are examples of non-life size drawing types.

AutoCAD first gained popularity in the early 1980’s when IBM introduced its 286 line of PCs. These new computers packed enough speed to make the use of applications such as AutoCAD feasible in the workplace. Up until this time, CAD applications were only available to those companies who could justify the purchase of expense main frame computers and proprietary software applications.

As AutoCAD evolved over the years, new interface methods were introduced (the move from DOS to Windows operating system accounted for many additions). Always sensitive to its current user base, existing techniques were retained as new methods were added. This variety can be confusing for new users.

In addition to the previously mentioned drafting and math skills, new AutoCAD users will be more successful with an understanding of saving and opening files, managing folders, choosing commands from menu, toolbars and palettes.

Document Conventions

Concepts in this AutoCAD training manual are presented in an explanation and exercise manner. In other words, one or more concepts are explained, followed by exercises that allow you to practice and perfect the techniques presented in the previous explanation(s). Although you may be tempted to try out the concepts while reading the explanations, it is recommended that you read the explanation completely and then move on to the related exercise. It is also helpful to read several steps ahead in each exercise to gain a better understanding of what you are being asked to do.
The conventions below are used to help students differentiate between explanations and instructions in exercises.

**Bold** letters highlight a selection, input value or a name, such as button or file name.

**Left-Click**
Left-click is used to select or pick points, objects, buttons and menu items.

**Right-Click**
A right-click generally displays a shortcut menu. The contents of the menu will vary based on the location of your pointer and the current command. If there is no shortcut menu available, a right-click will function as the ↵ key (ENTER).

**Right-Click Options**
This document assumes that the right-click settings are fully enabled. If the right mouse button is not performing as outlined in an explanation or exercise, make sure the double click editing and shortcut menus in drawing areas boxes are checked. Select **Tools > Options**, then the **User Preferences** tab. Click the **Right-Click Customization** button. Make sure your settings are the same as those in the figure show here.

**Space Bar**
The Space Bar functions as the ↵ key (ENTER) except when typing text or object names. Commands, command options and numbers do not contain spaces.

**Escape**
Use the ESC key on the keyboard to cancel or stop an operation.

**Undo**
TheUndo button is not available while a command is active. Clicking the Undo button reverses the result of the last command. Any operations performed transparently in the last command will also be undone.

**Beginning AutoCAD**
The AutoCAD program is launched (begun) like any program. You may navigate the program menus accessed from the Start button or use an icon on the desktop to begin AutoCAD.

**Using the Start Button to Launch AutoCAD**
A program menu group is created during installation. To launch AutoCAD using the Start button, click on the Start button, then All Programs, then Autodesk, then AutoCAD 2010, then AutoCAD 2010.

**Using a Shortcut to Launch AutoCAD**
During installation an icon (shortcut) is placed on the Windows Desktop. In addition to launching AutoCAD, this shortcut contains several settings that control the AutoCAD session.

Simply double-click on a shortcut to begin AutoCAD. If you do not have a desktop shortcut, access the shortcut in from the Start button, hold the CTRL key and drag the shortcut to your desktop.
AutoCAD User Interface

The figures below outline several parts of the AutoCAD window.

A. Drawing Area
B. Menu Browser
C. Ribbon Tabs
D. Panel Display
E. Ribbon Control
F. Ribbon Panel
G. Cursor
H. UCS Icon
I. Vertical Scroll Bar
J. Horizontal Scroll Bar
K. Command Window
L. Status Line Toggles
M. Layout, View, Annotation, Workspace Controls
N. Palette

You can switch to the Ribbon interface by selecting 2D Drafting & Annotation from the Work Switching button (Gear Icon) at the bottom, right of the AutoCAD Window.

O. Menu Bar
P. Various Toolbars
Q. Layout Tabs

You can switch to the toolbar and menu interface by selecting AutoCAD Classic from the Work Switching button (Gear Icon) at the bottom, right of the AutoCAD Window.
Choosing Commands

AutoCAD includes numerous methods of executing commands. Some of the more common techniques are using the keyboard, selecting from a ribbon panel and choosing from a toolbar.

Using the Keyboard

When you plan to type a command name, make sure you have completed all the steps of the previous command or just press **ESC** to cancel any active command without finishing. The previous command is complete if the last **Command:** prompt is blank (see figure below). All keyboard entries are displayed in the Command Window, located at the bottom of the AutoCAD window.

The Command Window displays commands that you have requested, prompts issued by those commands and your response to those prompts. Think of the Command Window as your review mirror.

![Command Window](image)

For most commands, a command line with two or three lines of previous prompts, called the command history, is sufficient. For commands with text output, such as DIST, you might need a larger command window. Once there is more than one line of command history, you can scroll through the history with scrollbars. You can also use the AutoCAD text window. The Text Window is a window similar to the command window in which you can enter commands and see prompts and messages. However, you can't dock the Text Window, you can only place it in front of or behind the application window with the **F2** key.

Selecting from a Ribbon Panel

Ribbons are the default interface method in AutoCAD 2009. If the Ribbon Interface is not visible, you can switch to it by selecting 2D Drafting & Annotation from the Work Switching button at the bottom, right of the AutoCAD Window.

![Ribbon Interface](image)

Ribbon Panels are organized on various Ribbon Tabs. The default tabs are Home, Blocks & References, Annotate, Tools, View and Output.

Panel Display

Many Ribbon Panels display only the most commonly used tools within the group. If present, clicking the triangle in the lower right corner exposes the hidden tools. To make the panel stay exposed, click the pushpin in the corner.

Ribbon Panel Control

This control allows three Ribbon Panel displays:
Choosing From a Toolbar

Prior to AutoCAD 2009, the default user interface was comprised of toolbars and menus. You can switch to the toolbar and menu interface by selecting AutoCAD Classic from the Work Switching button at the bottom, right of the AutoCAD Window.

Toolbars contain tools that represent commands. When you move the pointing device over a tool, Tool Tips below the cursor display the name of the tool.

You can display multiple toolbars on screen at once, change their contents, resize them, and dock or float them. A docked toolbar attaches to any edge of the graphics window. A floating toolbar can lie anywhere on the application screen, and it can be resized. A docked toolbar can't be resized and doesn't overlap with the drawing window.

Displaying Toolbars

A toolbar may be displayed by moving your pointer over a toolbar button and right-clicking. The toolbars from that button menugroup will be displayed in a menu. Those with a check mark are visible. To make a toolbar visible, check the toolbar name from the menu. Hover over the gripper edge of toolbar to display the toolbar name.

Moving Toolbars

Click and hold on the grippers at the beginning of a docked toolbar to move it. Click and hold gripper floating toolbar to move it. Release the mouse button when you have place the toolbar in the desired location.

Locking Toolbars

You can control whether or not Toolbars and Windows are movable or not by choosing the Lock Location menu item shown above and at the right.

Floating vs. Docked Toolbars and Windows can be locked and unlocked to maintain a consistent interface. You can temporarily override a locked item by holding the CTRL key down and dragging the Toolbar or Window.

Floating Toolbars

The toolbars may be displayed in one of two modes, floating and docked. A toolbar can only be resized if it is floating.
Resizing Floating Toolbars

Toolbars can be resized by clicking and holding the pick button on your mouse on an edge of the window. The pointer will be displayed as a double arrow. You can then drag the window to the desired shape.

Using Menu Search to Find Commands

Are you wondering where a command is hiding? Finding commands in a new application can be frustrating, but there is a simple way to expose the little devils.

The Menu Browser (AutoCAD 20009) or Application Menu (2010) contains a menu search function that allows you to find the location of a command.

Just activate the Menu and start typing in your command.

The more characters you input the narrower the results become.

Once you find the desired command you can select it from the menu or make a note of its location.
Using Help

The Help command (A) is useful for locating commands in the user interface and learning more about commands. You can also search for help using the Info Center (B).

The Help command can be accessed in a number of ways. Pressing F1 or selecting the ? button along the top right portion of the title bar are probably the two fastest methods of launching the Help window.

If you are looking for Help with a particular command, click the Search tab, type in the command name and click the Search button. Usually the result labeled (Quick Reference) is good place to start as it includes a brief explanation of the command and where it is located in the User Interface.

Once you are finished you can minimize or close the Help window using the controls at the top of the window.
Windows Files and Folders

The following pages are an overview of the general operation for Windows.

Opening Files and Folders

After you've located the file you want, you can double-click to open it.

To open a file or folder
1. On the desktop, double-click **My Computer**.
2. The My Computer window opens.
3. Double-click the drive that contains the file or folder you want to open.
4. Double-click the file or folder.

Renaming Files and Folders

If you decide to change the name of a file or folder, you can quickly rename it.

To rename a file or folder
1. In a window, select the file or folder you want to rename.
2. On the **File** menu, click **Rename**.
3. Type a name, and then press **ENTER**.

Copying and Moving Files and Folders

When you create files and folders, you may want to copy or move them to another location. Unless you're an advanced user, you should avoid moving program and system files.

To copy or move a file or folder
1. In a window, select the file or folder you want to copy or move.
   a. **Note** You can select multiple items. To select nonadjacent items, hold down CTRL and click the items you want to select. To select adjacent items, hold down SHIFT while you select items. To select all of the items in a window, on the **Edit** menu, click **Select All**.
   2. On the **Edit** menu, click **Copy** to copy the file, or click **Cut** to move the file.
   3. Double-click the folder in which you want to place the file or folder.
   4. On the **Edit** menu, click **Paste**. The file appears in its new location.

Deleting Files and Folders

Whenever you delete a file, it's temporarily moved to the Recycle Bin on your desktop. If you change your mind, you can restore the file. However, when you empty the Recycle Bin, all of the items in it are permanently deleted from your computer.

To delete files and folders
1. On the desktop, double-click **My Computer**. The My Computer window appears.
2. Select the file or folder you want to delete. On the File menu, click **Delete**. The **Confirm File Delete** dialog box appears. Click **Yes**. The file is moved to the Recycle Bin.

To permanently delete files
1. On the desktop, double-click **Recycle Bin**.
2. The Recycle Bin opens.
3. On the **File** menu, click **Empty Recycle Bin**.

To retrieve deleted files or shortcuts
1. On the desktop, double-click the .
2. Click the file or shortcut you want to retrieve.
3. On the **File** menu, click **Restore**.
Notes

1. If you restore a file that was originally located in a deleted folder, the folder is recreated, and then the file is restored in the folder.
2. Files deleted at the command prompt, files deleted from network locations, and files deleted from removable media (such as disks) are not moved to the Recycle Bin. They are permanently removed when you delete them.
3. To open a file that is in the Recycle Bin, drag the icon onto the desktop, and then click it.
4. To retrieve several files at once, hold down the CTRL key, click each file you want to retrieve, and then click Restore on the File menu.

Switching between programs

The taskbar is located at the bottom of the desktop. Whenever you open a program or document, a button for it appears on the taskbar. The taskbar works like the Macintosh Application menu, but instead of opening a menu, you click the taskbar button that represents the program you want to switch to.

Switching between files

1. In AutoCAD you can switch between files by selecting CTRL+TAB.

Saving documents

You save documents by using the Save or Save As command on the File menu. Here are a few things you need to know when saving documents:

- In Windows, the hard disk drive and floppy disk drives are identified by letters. Most hard disk drives are assigned C or D.
- A path tells you where a file is located. For example, a path could be: C:\Projects\Smith Machining\Spindle.dwg. This tells you that the Spindle.dwg document is located on the C drive in a folder named Projects that is in the Smith Machining folder.
- You can change the location of a file in the Save As dialog box.

Manipulating windows in Windows

The small buttons in the upper-right corner of a window are very handy.

- Use the (Minimize) button to reduce the window to a button on the taskbar. Click the taskbar button to open the window again.
- Use the (Maximize) button to enlarge the window so that it covers the entire desktop (except for the taskbar).
- Use the (Restore) button to return the window to its pre-maximized size.
- Use the (Close) button to close the window.
Opening a Drawing

Use the **Open** command to make changes to a drawing that already exists.

To open a drawing you must find the folder where it has been saved. You can look at the contents of other folders by clicking the **Up one level** button or going **Back** to the previous place you looked. Each folder may contain other folders and files.

Use the **Look in**: list to look in other places for the file you wish to open.
You can create a shortcut to frequently accessed folders by right-clicking in the Folder Shortcuts pane and choosing Add Current Folder.

Most of the time you will open DWG files, but AutoCAD can open DWG, DWT, DXF and DWS files. The type of file is specified in the Files of type: drop down at the bottom of the window.

- DWG – AutoCAD drawing file
- DWT – AutoCAD drawing template file
- DXF – AutoCAD exchange file
- DWS – AutoCAD drawing standard file

**Closing a Drawing or Exiting AutoCAD**

Although you may have several files open, it is best to close files when not actively working on them. To close a file:

- Click the Menu Browser, File, then Close.
- Click the X corner of the drawing window.

Be careful not to select the X at the end of the Title bar. This exits AutoCAD.

**Beginning a New Drawing**

The New command is used to begin a brand new file.

Typically when a new drawing is started, a Template file is selected to establish a beginning work environment. There are a number of templates files included with AutoCAD and you can easily create template files to suit your particular needs.

When the New command is selected, the Select template window is displayed showing the contents of the designated Template folder.

Double-clicking the ACAD.DWT begins a drawing with minimal settings for an inch based drawing. The ACADISO.DWT establishes a metric environment with minimal settings.

The new drawing will be given a proposed file name DRAWING#.DWG. When you save the drawing you will have a chance to change the filename.
Displaying Areas of a Drawing

Typically designs created with AutoCAD are not viewable in great detail when the entire design is fit on the screen. Often an area of the design needs to be enlarged to work on it properly. You will need to become acquainted with Zoom and Pan functions to work on your drawings efficiently. The wheel on your mouse or the middle button on a three button mouse can be used to perform a select group of zoom and pan operations.

Viewing The Entire Drawing

Double-clicking on the wheel or middle button performs a **Zoom Extents** function. Zoom Extents will fill the drawing window with the geometry in the drawing.

Enlarging or Reducing the Image

If your mouse has a wheel, you can enlarge the drawing view by rolling the wheel up. Rolling the wheel down decreases the size of the drawing image.

If you don't have a wheel mouse, click on the Real Time Zoom button. Left-click and hold down the mouse button in the drawing area while moving the mouse up. This will enlarge the view. Left-click and hold in the drawing while moving the mouse down will shrink the view. Note: This operation does not change the size of the objects in your drawing. It only changes the image size, like using a zoom lens on a camera.

Viewing An Adjacent Area

There are several ways to display a nearby area of the drawing.

- Use the scroll bars. See the User Interface section for the location of the scroll bars.
- Press and hold the wheel or middle mouse button. Move the mouse.

**Zoom In and Out**

The **Zoom In** and **Zoom Out** selection increase and decrease the magnification by 50%. These options are handy when the wheel mouse is unable to calculate the new display.

Zoom In (+) and Zoom Out (-) can be found in the Zoom Toolbar and the Zoom flyout on the Navigate Panel, View Tab.

Selecting Objects

Many commands in AutoCAD require you to select objects. Objects can be selected in a variety of ways. Typically, users select objects one at a time or with a window or crossing selection. Objects can be selected first, then the command selected or the command selected first and then the objects.

**Verb, Noun and Noun, Verb**

When a command is selected first, then the objects to be modified are selected it is called **verb, noun** selection. The prompt, **Select objects:** will be displayed. Any number of objects may be selected, so you must press **ENTER** to finish selecting objects and move on to the next step of the command.

If the objects are selected first, then the command used to modify the objects selected, it is known as **noun, verb** selection. When noun, verb selection is used, you can choose the command to modify the objects by selecting it from a toolbar, menu or right-clicking to display a shortcut menu. Choosing the command in effect completes the selection, so there is no need to press **ENTER**.
Selecting Objects One at a Time

To select a single object, place your pointer over the object and click. You can continue building the selection set by clicking the edge of more objects, unless the **Use Shift to add to selection** setting is enabled. This setting is adjusted by selecting **Tools > Options**, then the Selection Tab. You must select the edge of objects. For instance, click on the edge of a circle, not inside the circle to select it.

Selection Preview Effect

The **Selection Preview Effect** (AutoCAD 2006+) aides in determining if your cursor is close enough to an object to select it. As your pointer moves over an object, the object appears dashed, thickened or both. This setting is adjusted by selecting **Tools > Options**, then the **Selection Tab** and **Visual Effects** button.

Removing Selected Objects

Sometimes it is more convenient to select a group of objects and remove those that will not be affected by the command. To remove objects from a selection set, hold down the **Shift** key and select the unwanted objects.

Selecting With a Window

Objects in close proximity may be selected using a **window**. A window selects objects that are entirely within the boundaries of the window. A selection window may be implied by left-clicking a point in an empty space, moving to the right and left-clicking again (release the mouse button, do not hold it down). The box will be a solid line. A selection window may also be indicated by typing **W** and pressing **ENTER** when prompted Select objects:. The location of the second corner of the window (left or right) is not important when you type **W** and press **ENTER**.

Selecting With a Crossing

Objects in close proximity may also be selected using a **crossing**. A crossing selection selects objects that are entirely within the boundaries of the crossing and those that touch the window. A selection crossing may be implied by left-clicking a point in an empty space, moving to the left and left-clicking again (release the mouse button, do not hold it down). The box will be a dashed line. A selection crossing may also be indicated by typing **C** and pressing **ENTER** when prompted Select objects:. The location of the second corner of the window (left or right) is not important when you type **C** and press **ENTER**.
Area Selection Effect

The Area Selection Effect (AutoCAD 2006+) aides in distinguishing between Crossing and Window selection areas. By default, the interior of a Window selection is Blue. The interior of a Crossing selection is Green. This setting is adjusted by selecting Tools > Options, then the Selection Tab and Visual Effects button.

Erasing Objects

The Erase command is used to delete entire objects from the drawing. You can’t remove part of a circle or line using Erase.

To Erase an object:
- Select the object and choose the Erase command.
- Select the Erase command, choose the object and press ENTER (or right-click).

The Delete key is a shortcut to the Erase command, but only if you utilize Noun, Verb selection.

To Erase an object using the Delete key:
- Select the object and press the Delete key.

You can restore erase objects by using the OOPS command. The Oops command restores the last group of erased objects. The Oops command is not located in any toolbar or menus. Type OOPS and ENTER to restore deleted objects.

Using Right-click Menus

A right-click or shortcut menu is typically displayed when you press the right mouse button. Different menus are displayed based on the location of your cursor and current activity.

<table>
<thead>
<tr>
<th>Default Command</th>
<th>Default Edit</th>
<th>Command Mode</th>
<th>Hot Grip</th>
<th>OSNAP</th>
</tr>
</thead>
<tbody>
<tr>
<td>Right-click in drawing area, no command active, no objects selected.</td>
<td>Right-click in drawing area, objects selected, no grips selected, no command active.</td>
<td>Right-click in drawing area, command active, option keywords inserted in boxed area.</td>
<td>Right-click in drawing area while a grip is selected.</td>
<td>Shift+Right-click in the drawing area.</td>
</tr>
</tbody>
</table>

If no shortcut menu exists for the current content, a right-click is the same as pressing ENTER.
Picking Points

Most commands require at least one location or point value. Points can be selected:

- by left-clicking in the drawing area
- at a geometric location based on an object by using an Object Snap
- at an absolute point using linear coordinates
- at an absolute angle and distance using polar coordinates
- relative to the last point at an angle using a relative polar coordinate, dynamic input or polar tracking
- relative to the last point at a horizontal and vertical offset using a relative linear coordinate or dynamic input

Left-click

To visually choose a location in your drawing, position your cursor in the drawing area and left-click. The words pick, choose, select and click are all used to mean left-click.

Drawing a Line

The **Line** command is one of the simplest drawing commands in AutoCAD.

The **Line** command actually allows you to draw a series of lines by choosing an indeterminate number of points. Imagine picking up a pencil and placing the pencil point on the sheet of paper. This is your **first point**. Next you move the pencil in a straight line. When you stop moving the pencil you have designated the **next point**. You can continue drawing a series of lines in this fashion until you pick up the pencil. Although the lines are created as part of a single command, they are in fact separate, individual lines.

Drawing a Series of Connected Lines

To actually draw a Line in AutoCAD, choose the **Line** command. When prompted for a **First point**, click a spot in the drawing window. Move your pointer to a new location in the drawing and click to designate the **Next point**. Continue clicking **Next points** until you are finished drawing lines. Press **ENTER** to pick up your pencil.

Undoing a Line Segment

If you click an incorrect point while drawing Lines, you can back up by typing **U** and pressing **ENTER** or right-clicking and selecting **Undo** from the menu. However, if you have completed the **Line** command typing **U** and pressing **ENTER** will undo the entire series of lines just created.
Closing a Line Sequence

The Line command can create the final line necessary to create a closed figure if you type `C` and press ENTER or right-click and selecting Close from the menu. Note that this option is only available if you have drawn a minimum of two line segments in the current Line command.

Polar Tracking

When you want to draw straight lines with a pencil, you use a ruler. If the lines are to be drawn at specific angles, you might use a T square and triangle or drafting machine.

Measurement of Angles

By default in AutoCAD, angles are measured counter-clockwise with 0º being parallel to and in the direction of the positive X Axis. The settings for angles can be changed in the UNITS command.

To indicate direction at specific angles in AutoCAD, you can use a tool named Polar Tracking. When turned on, Polar Tracking will guide the movement of your pointer along specified angles. You can choose among many different increment angles. Each of the increment angles divides evenly into 180. Polar Tracking can be use in any command that has a first point, second point relation. When your pointer is moving in a direction close to a Polar Tracking increment, a thin dotted line is displayed.
Setting the Polar Increment Angle
Right-click on POLAR at the bottom of the AutoCAD.

Common increments are displayed on the right-click menu. Other features can be chosen by selecting Settings… from the menu.

Choose the Use Icons selection to toggle between icons and text bases labels in the status line.

Options for Polar Tracking are controlled on the Polar Tracking tab of the Drafting Settings window.

The list of included increment angles (A) can be accessed by selecting the arrow next to the drop down list below the Increment Angle label. Increment angles are 5, 10, 15, 18, 22.5, 30, 45 and 90.

Additional angles can be added by placing a check mark next to Additional angles. Then click the New (C) button and enter a new angle. Note that this is not a new increment angle, but a single direction for use in Polar Tracking. For example, if you enter 8 as a new angle, 18, 24, 32 etc. will not be used in Polar Tracking. Additional angles can be removed by using the Delete button.

Setting Polar Angle Measurement
Typically Polar Tracking is used in the Absolute mode, meaning that the guidelines appear at the same angle regardless of the angle of the previous segment.

To enable Polar Tracking Relative to the last segment, click the radio button (B).

Turning Polar Tracking On
Turn on Polar Tracking by placing a check mark in Polar Tracking On (F10) box. Just because you have set the Increment angle doesn't mean that Polar Tracking has been turned on. Note: Polar Tracking can also be turned on and off by using the F10 function key or left-clicking on Polar in the status line at the bottom of the AutoCAD window.

Selecting the OK button completes Polar Tracking.
Dynamic Input Entry

AutoCAD 2006 introduced the concept of Dynamic Input. Dynamic Input displays prompts and allows options to be selected near the cursor. Dynamic Input is turned on in this example. The DYN button indicates the status of Dynamic Input. The Circle command will be used to demonstrate various input methods.

DYN Display Elements

The following prompt is displayed near the cursor once the Circle command is selected.

1: The basic command prompt.
2: Access to the option keywords.
X: X coordinate of cursor location.
Y: Y coordinate of cursor location.

Option Keywords may be selected by typing the portion of the option that is capitalized or right-clicking and selecting the option from the menu. However, option keywords may also be displayed by pressing the down key on the keyboard. The menu is displayed as shown in the figure.

This circle is still drawn using a center point method. After selecting the center point the Dynamic Input prompt changes. The format is similar to the previous one, but the dynamic circle size is displayed rather than the X, Y cursor location.

When you type the size of the circle, it is displayed in the Dynamic Input area.

Relative Polar Coordinates via Dynamic Input

Points may be also entered via Dynamic Input. One common type of coordinate entry is called Relative Polar Coordinates. A Relative Polar coordinate involves specifying a distance and a direction. Although a Relative Polar it is entered relative to the last point input. Dynamic Input by default is set to use Relative Polar Coordinates, so it is not necessary to type @ as in the traditional input method. Refer to the compass at the right for directions used with Polar Coordinates.
Using Dynamic Input to Draw Lines

Once the Line command is selected the prompt is displayed near the cursor. Simply left-click in the drawing area to specify a starting point for the line.

1: The distance of the cursor from the last point.
2: The relative angle of the cursor from the last point.

The length of the line can be typed in the Dynamic Input area for distance (1).

To change to the relative angle input area press the TAB key.

The length of the line is now locked (see the lock icon next to the typed distance). As you move your cursor around the drawing, the length remains fixed.

The relative angle input area is active. Type an angle and press ENTER to complete the coordinate.

The line command continues to prompt for additional points, so press ENTER to finish.

Let’s draw another line, this time locking the relative angle first.

Right-click in the drawing area and select Repeat Line from the shortcut Menu. You will see the same initial prompt as before.

Simply left-click in the drawing area to specify a starting point for the line.

The focus of the Dynamic Input begins in the distance area. Pressing the TAB key to switches to the relative angle input area.

The relative angle input area is active. Type an angle.
Pressing the **TAB** key to switches to the distance input area.

The relative angle of the line is now locked (see the lock icon next to the typed angle). As you move your cursor around the drawing, the angle remains fixed.

Type the distance.

Press the **TAB** key. The relative angle input area is active again. You could change the relative angle again. In fact, you can continue pressing the **TAB** key and change the distance and relative angle values until you press **ENTER**. Try this and press **ENTER** when finished.

### Object Snaps

Object Snaps are tools that help select exact geometric locations, like Endpoints, Midpoints, Intersections and Quadrants.

Objects Snaps (Osnaps) can be used in a running mode and override (immediate) mode. When used in the running mode, Osnaps are active in portions of a command that request points. While several Osnaps may be active at any one time, more is not necessarily better. Each Osnap has a different weight, meaning that if multiple Osnaps are active the ones with more weight will be used. For example, the Center Point Osnap carries so much weight that the Tangent Osnap is disabled if the Center Point Osnap is also set. Running Osnaps are configured in the Drafting Settings window which is accessed from Drafting Settings menu, the Osnap toolbar or from the Status line.

### Using Running Object Snaps

The status line is located near the bottom of the AutoCAD window and contains a variety of features that can be toggled on and off. Many have settings that can be accessed by right-clicking on the button.

Choose the **Use Icons** selection to toggle between icons and text bases labels in the status line.

To set a running Osnap, right-click on **OSNAP** in the status line and select the desired mode from the menu. Current modes display a box around the Osnap symbol.

The **Settings...** selection can also be used to choose Running Obect Snap modes.
Choosing the OSNAP Mode

The Running Object Snap settings are part of the Drafting Settings dialog. To set a running Osnap, remove check next to any undesired modes. Click the box next to the desired mode(s).

Click the **OK** button when finished.

Items in the Status Line appear depressed when turned on. Left-clicking on a button in the Status Line turns the feature on and off. The function keys listed in parenthesis can be used to toggle the setting on and off as well.

---

### Using Immediate Object Snaps

Immediate Object Snaps override or suspend any running object snaps for one point selection. After the immediate Osnap is used, the running Osnap is active again. Immediate Osnaps can be selected from the Object Snap toolbar or by holding the **Shift** key and right-clicking to display a menu.
Drawing a Line from Endpoint to Endpoint

The Endpoint Object Snap acquires the precise end of a line or arc.

**Setting a Running Endpoint Object Snap**

To set a running Endpoint Object Snap:
1. Right-click on the Object Snap icon or label in the Status Line.
2. Click **Settings...** from the list.
3. Click the **Clear All** button.
4. Click Endpoint.
5. Click the **OK** button.

**Drawing the Line**

1. Select the **Line** command.
2. Place your cursor near the desired end of the line. When the **Endpoint** marker to appears, click the line.
3. Place your cursor near the desired end of the other line. When the **Endpoint** marker to appears, click the line.
4. Press **ENTER** to stop drawing lines.

Drawing a Line from Midpoint to Midpoint

The **Midpoint** Object Snap acquires the point at the middle of a line or arc. A circle has no midpoint.

**Setting a Running Midpoint Object Snap**

To set a running Midpoint Object Snap:
1. Right-click on the Object Snap icon or label in the Status Line.
2. Click **Settings...** from the list.
3. Click the **Clear All** button.
4. Click Midpoint.
5. Click the **OK** button.

**Drawing the Line**

1. Select the **Line** command.
2. Place your cursor near the desired end of the line. When the **Midpoint** marker to appears, click the line.
3. Place your cursor near the desired end of the other line. When the **Midpoint** marker to appears, click the line.
4. Press **ENTER** to stop drawing lines.

**Getting Distances**

The **Dist** command is used get the distance between two points. You can’t add a dimension using the Dist command, only obtain a distance.

To use the **Dist** command, choose the command and select two points. To acquire a precise distance, make sure to use an Object Snap. The results will be displayed in the **Command** window. You may need to expand the Command window to a Text window by pressing **F2**. You can close the Text window by pressing **F2** again.

The results of the **Dist** command will be formatted based on the settings established in the **Units** command.
Formatting Numbers

Numbers without a measurement symbols (" or ") can be input at anytime. However, to use an inch (") or foot (') symbol you must use a Length unit that supports these characters. The same is true of angles, the degree symbol is only allowed in certain Angle types.

Length and angle settings are managed with the Units command.

Lengths and angles can be expressed in many formats. For instance, construction documents usually format lengths in feet and fractional inches (54'-4 3/8"). Surveys and part drawings typically use decimal numbers (13.5).

The precision of lengths can vary also. A drawing showing the dimensions of a parking lot may formats lengths no less than a multiple of ½" while a wall section is measured to the nearest 1/8". Parts measured in millimeters rarely show more than 2 decimal places, but those using inches may utilize up to 4 decimal places.

Display versus input

Some of the length and angle settings format numbers with characters that are not found on a keyboard or include spaces (spaces not allowed in numbers). Therefore, certain formats display numbers differently than the allowable input format. For instance, keyboards don’t include a degree symbol. To input a Degree – Minute – Second angle a D is used in place of the degree symbols, ie. 33°12’ is entered as 33d12’. Architectural lengths are displayed with a space. To input an Architectural length, the space must be removed and replaces with a hyphen (-). 23'-6 3/32" is input as 23'6-3/32".

The same length format (decimal) can be used with several units of measure. Surveys assign a unit of measure of feet. Metric drawings may regard a length of 1 as a millimeter or a meter. Imperial (inch) drawings assume a length of 1 is an inch.

Most people measure angles in degrees but, there are three commonly used formats: Decimal Degrees, Degrees - Minutes – Seconds and Surveyor’s Units. As with lengths, angles can be expressed using varying precisions.

<table>
<thead>
<tr>
<th>Length Formats</th>
<th>Angle Formats</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scientific</td>
<td>Decimal Degrees</td>
</tr>
<tr>
<td>Decimal</td>
<td>Degrees – Minutes - Seconds</td>
</tr>
<tr>
<td>Engineering</td>
<td>Radians</td>
</tr>
<tr>
<td>Architectural</td>
<td>Grads</td>
</tr>
<tr>
<td>Fractional</td>
<td>Surveyor’s Units</td>
</tr>
</tbody>
</table>

AutoCAD supports many Units of Measure. The Unit of Measure determines what measurement system applies to a length of 1 (one). This Unit of measure is used by other commands to convert objects created with one unit of measure to the unit of measure currently in use.

Insertion scale (Units of Measure)

<table>
<thead>
<tr>
<th>Inch</th>
<th>Millimeters</th>
<th>Light Years</th>
</tr>
</thead>
<tbody>
<tr>
<td>Feet</td>
<td>Centimeters</td>
<td>Parsecs</td>
</tr>
<tr>
<td>Miles</td>
<td>Kilometers</td>
<td>More...</td>
</tr>
</tbody>
</table>

The current Unit setting primarily controls the display of lengths and angles. It can also expand the options for enter lengths and angles. The foot symbols ('') is only accepted if the Length format is Architectural or Engineering. Decimal and fractional input is always accepted.
### Drawing a Circle

After the Line command, the Circle command is probably the next easiest draw command to use. Typically, circles are drawn by specifying the Center point and then the Radius or Diameter of the circle. However, there are additional methods available to draw circles.

#### Center point Radius Circles

Once the Circle command is selected, you are prompted to choose a Center point. A group of options in square brackets [ ] are also listed in the prompt, but let’s save that for later. The next piece of information the Circle command expects is the Radius. The Radius can be specified by typing a number followed by ENTER or moving your pointer away from the Center point and clicking. Note that without the use of another tool, the last method isn’t an accurate way to indicate the size of the circle.

#### Center point Diameter Circles

To draw a Circle by using the diameter you must remember to choose the Diameter option at the appropriate moment. After selecting the Circle command and clicking a Center point, right-click and select Diameter from the menu or type D and press ENTER. Then move your pointer away from the Center point and click or type a number and press ENTER.

#### 2 Point Circles

The 2P option can be used to draw a circle when you know any two points along the circumference of a circle that define a diameter. Two points define a diameter if a line connecting the two points passes through the center point of the circle.

To create a 2P circle, first select the Circle command. Next right-click and select 2P from the menu or type 2P and press ENTER. Then select two points.

#### 3 Point Circles

The 3P option is similar to the 2P option, but the three points selected are simply three points on the circumference or edge of the circle.

To create a 3P circle, first select the Circle command. Next right-click and select 3P from the menu or type 3P and press ENTER. Then select three points.
**Tan, Tan, Radius (TTR) Circles**

The Tan, Tan, Radius circle option draws a circle tangent to two objects with a specified radius.

To create a TTR circle, first select the Circle command. Next right-click and select Ttr (Tan, Tan, Radius) from the menu or type TTR and press ENTER. Then select two objects. Finally, type in the radius of the circle and press ENTER.

**Tan, Tan, Tan Circles**

The pull down menu and ribbon interfaces includes an option named Tan, Tan, Tan. This option is really the 3P option with a Tangent built in to each of the pick points.

To create a Tan, Tan, Tan circle, first select Tan, Tan, Tan from the Circle flyout in the Draw menu or Home>Draw ribbon tab/panel. Then select three objects.

**Drawing a Line from Quadrant to Quadrant**

The Quadrant Object Snap acquires the quadrant point of an arc or circle closest to the cursor.

**Setting a Running Quadrant Object Snap**

To set a running Quadrant Object Snap:
1. Right-click on the Object Snap icon or label in the Status Line.
2. Click Settings... from the list.
3. Click the Clear All button.
4. Click Quadrant.
5. Click the OK button.

**Drawing the Line**

1. Select the Line command.
2. Place your cursor near the desired quadrant on a circle. When the Quadrant marker to appears, click the circle.
3. Place your cursor near the next desired quadrant. When the Quadrant marker to appears, click the circle.
4. Press ENTER to stop drawing lines.

**Drawing a Circle At the Center of an Existing Circle**

The Center point Object Snap acquires the center point point of an arc or circle closest to the cursor.

**Setting a Running Center point Object Snap**

To set a running Center Object Snap:
1. Right-click on the Object Snap icon or label in the Status Line.
2. Click Settings... from the list.
3. Click the Clear All button.
4. Click Center point.
5. Click the OK button.
**Drawing the Circle**

1. Select the **Circle** command.
2. Place your cursor on the edge of the desired circle. When the **Center** marker appears, click the circle.
3. Type the desired radius and press **ENTER**.

**Coordinates**

A basic understanding of coordinates is vital to using AutoCAD effectively. What is a coordinate? A coordinate is set of numbers that locate the position of a point. AutoCAD utilizes a three-dimensional coordinate system where points may be entered as two-dimensional (X,Y) or three-dimensional (X,Y,Z) values. When a two-dimensional coordinate is entered, Z is automatically set to 0. Let’s focus on two-dimensional coordinates (X,Y).

**Cartesian Coordinate System**

In a two-dimensional Cartesian coordinate system, X coordinates are arranged along a horizontal line or **axis** (X Axis). Y coordinates are set along line perpendicular to the X Axis, called the Y Axis. The intersection of these two axes is called the Origin. The value of both X and Y at the origin is 0,0.

Positions in the coordinate system are specified by pairing the X location followed by the Y location. The X component always comes first and the X and Y values are separated with a comma. The location of the point will be relative to the Origin of the Coordinate System. Example: 2,4.

Use Cartesian Coordinates when you know a point location within the coordinate system, not with respect to another object or point. Examples of Cartesian coordinates outside of AutoCAD are latitude and longitude on a map or a box on a chess board.

Relative Cartesian Coordinates

Relative Cartesian Coordinates are useful when you want to specify a new point a specified horizontal (X) and vertical (Y) distance from the last point. The @ symbol (last point) is used to designate a coordinate as relative. A relative Cartesian coordinate is entered as @X,Y.
Cartesian vs Relative Cartesian

Cartesian coordinates are sometimes referred to as Absolute Coordinates, because the coordinate designation refers to one and only one location. A relative Cartesian coordinate refers to a movement, often referred to as *displacement or offset*. A chessboard uses a coordinate system of letters and numbers to identify the squares on the board. The location of each piece has an absolute coordinate comprised of a letter and a number. For instance, the black king below is located in square E8.

Four black pawns have been moved from their original positions. Although each pawn is located in a different square, each was moved the same relative amount (one square down vertically). The displacement of each of these pawns is @0,-1.

What are the Cartesian coordinates of the two white knights (horses)?

What is the relative displacement (relative Cartesian) of the two white knights (horses) from their starting positions?

Polar Coordinates

Polar Coordinates identify the location of the point by using a distance and direction DST<DIR. The location of the point will be at a distance (DST) and direction (DIR) from the Origin of the Coordinate System. Example: 3<45.

Relative Polar Coordinates

A Relative Polar Coordinate is used to specify a new point at a certain distance and direction from the last point. The @ symbol (last point) is used to designate a coordinate as relative. A relative polar coordinate is entered as @DST<DIR. Example: @4<135.
Drawing a Rectangle

While the Line command can be used to draw a rectangular shape, it is more efficient to use the `Rectang` command.

Rectangles can be drawn using a variety of options, but typically they are drawn by choosing a **first corner** point and then the **other corner point**. As with selecting any points visually in the drawing, these corners are selected by clicking. A group of options in square brackets [ ] are also listed in the prompts, but let’s save that for later.

While Rectangles often are drawn by choosing a **first corner** point and then the **other corner point**, another useful option is to provide the Length (horizontal) dimension and Width (vertical) dimension of the rectangle. To use the **Dimensions** options, first provide a **first corner** for the new rectangle. The next prompt will contain a number of options within [ ]. To choose the Dimensions options, type D and press ENTER or right-click and select Dimensions from the menu. You can enter the Length and Width using the keyboard or select two points in the drawing to provide one or both values. After inputting the Length and Width, you will need to select the **other corner point** to finalize the rectangle’s position.

Drawing a Polygon

The **Polygon** command is used to draw an equilateral figure from 3 to 1024 sides. A Polygon may be drawn using two basic techniques; both begin by prompting for the number of sides of the polygon.

Polygons are most commonly drawn by selecting a center point and choosing to inscribe or circumscribe the polygon with respect to a circle of a specified radius. The circle need not actually exist. Although the polygon is located by choosing the center of the polygon, it is not possible to object snap to the center of the Polygon, since in reality it is a Polyline.

If the distance from the center of the polygon to one of the vertices is known, the inscribed option is best. The circumscribed method is best when the distance from the center of the polygon to the midpoint of one of the sides is known.

To draw a Circumscribed Polygon:

1. Select the **Polygon** command
2. Type the number of sides and press ENTER.
3. Choose a center point for the polygon.
4. Right-click and select **Circumscribed** from the menu or type C and press ENTER.
5. Type the radius of a circle about which the polygon could be circumscribed and press ENTER.

To draw an Inscribed Polygon:

1. Select the **Polygon** command
2. Type the number of sides and press ENTER.
3. Choose a center point for the polygon.
4. Right-click and select **Inscribed** from the menu or type I and press ENTER.
5. Type the radius of a circle in which the polygon could be inscribed and press ENTER.

The second technique involves identifying the endpoints of one edge of the Polygon.

To draw an Edge defined Polygon:

1. Select the **Polygon** command
2. Type the number of sides and press ENTER.
3. Right-click and select **Edge** from the menu or type E and press ENTER.
4. Choose one end of an edge of the polygon.
5. Choose the other end of the edge of the polygon.
Aligning Points With Object Snap Tracking

Object Snap Tracking (Otrack) works with Osnap and Polar to help align new points with existing locations in your drawing. For instance, Otrack makes it easy to draw a new rectangle in line with an existing one or draw a circle to align vertically with the midpoint of a line and horizontally with an intersection. Otrack only works with Running Object Snaps.

Enabling Object Snap Tracking

To turn on Otrack, just make sure the OTRACK in the status line is depressed.

Polar Tracking Settings and Otrack

Polar Tracking will guide the movement of your pointer along specified angles. You can choose among many different increment angles. You can choose to allow Otrack to use all polar angle settings or limit Otrack to track orthogonally only. This setting is accessed by right-clicking on POLAR at the bottom of the AutoCAD. Select Settings... from the menu.

To track using all angles, click the Track using all polar angle settings radio button. Click the OK button when finished.
**Using Otrack to Align with a Single Point**

To align new points with locations on existing objects, make sure Otrack and Polar are turned on. Set the running Osnap to the appropriate mode. In this example, a new rectangle will be aligned with an existing rectangle intersection.

Choose the Rectangle command. Place your pointer over the corner of the rectangle A. Do not click. Move your pointer in the desired direction B, along the Polar Tracking guide. When you are satisfied with the location, click. Complete the Rectangle command.

**Using Otrack to Align with Two Points**

To align new points with locations on existing objects, make sure Otrack and Polar are turned on. Set the running Osnap to the appropriate mode. In this example, a new circle will be drawn to align vertically with the midpoint of a line an horizontally with an intersection.

Choose the Circle command. Place your pointer over the edge of the line A. Do not click. Move your pointer in the desired direction, along the Polar Tracking guide.

Place your pointer over the intersection B. Do not click. Move your pointer toward the original Otrack point along the Polar Tracking guide C.

When you are satisfied with the location, click.

Complete the Circle command.
Locating Points Near Know Locations – From

The **From** Object Snap mode is used to locate a new point at an *offset* from a *base point*. It is used while using a command that prompts for a point location.

**From** is useful when positioning the center of a circle a given horizontal and vertical distance from an intersection. Circle A in the figure is to be located 2.0 to the right (positive X) and 2.0 up (positive Y) from intersection B. Then select the Circle command. To specify the center of the circle, hold the Shift key, right-click and select **Snap From** from the menu. Click Intersection B as the Base point. The Offset is input as @2.0,2.0 followed by ENTER. The Circle command is then completed normally.

The two examples below use a Running Object Snap of **Intersection** and **Midpoint**.

Similarly, the corner of a rectangle can be located with respect to an intersection, or any other point. Rectangle A in the figure is to be located so the lower right corner of the rectangle B is positioned 2.0 to the left (negative X) and 1.0 up (positive Y) from intersection C. Select the Rectangle command. To specify the first of the rectangle, hold the **Shift** key, right-click and select **From** from the menu. Click Intersection C as the Base point. The Offset is input as @-2.0,1.0 followed by ENTER. The Rectangle command is then completed normally.

Moving Objects

The **Move** command is used to relocate a group of objects.

The **Move** command requires you to select objects and supports both noun, verb and verb, noun selection. After the command and objects are selected you will be prompted to select a **Base point**. The base point is typically a point on or near the objects you are moving. After selecting a base point, you will need to choose a **Second point of displacement**.

The second point of displacement is the point where the objects are being moved to. Displacement is a fancy way of saying movement. The manner in which you specify the second point of displacement determines how accurately the object is moved. A frequent mistake is to forget to select the Base point.

If a dimension is linked to the moved objects, it will update.
**Copying Objects**

The **Copy** command is used to duplicate a group of objects.

The **Copy** command requires you to select objects and supports both noun, verb and verb, noun selection. After the command and objects are selected you will be prompted to select a **Base point**. The base point is typically a point on or near the objects you are moving. After selecting a base point, you will need to choose a **Second point of displacement**. The second point of displacement is the point where the objects are being moved to. Displacement is a fancy way of saying movement. The manner in which you specify the second point of displacement determines how accurately the copy is placed. A frequent mistake is to forget to select the Base point.

**Multiple Copies**

AutoCAD 2005+ automatically creates multiple copies. You will be prompted for the second point of displacement repeatedly until you press **ENTER**. If you are using an earlier version of AutoCAD, you can still make multiple copies. However, you will need to request the Multiple option when the **Base point:** prompt is displayed. Options to commands are displayed in [ ] and can be requested by typing the capitalized portion of the option or by right-clicking and selecting the option from the menu.

**Offsetting Objects**

The Offset command is used to create new objects parallel at a distance or through a point.

The following figure shows the results of offsetting several of the objects you have encountered so far. The red, thicker dashed object was created by offsetting the black, thin, continuous object nearby.

By default, the new objects have the same properties (Layer, Color, Linetype, Lineweight) as the object selected. AutoCAD 2006 included an option to place the new objects on the current layer.

The basic operation of the Offset command is to first input an offset distance. The offset distance is the perpendicular distance between the original object and the newly created object. After the offset distance is specified, the object to be offset is selected. In the previous figure, the objects to be offset are black, thin and continuous. Next, the side to offset the object is selected. This is done by clicking a location. Remember that the distance between the new and old objects was determined in the first part of the command. The black dots in the previous figure identify the locations clicked to specify the side to offset.

The result of offsetting a line resembles that of copying a line (**B**) and you could certainly use the **Copy** command instead of the Offset command. The advantage in using the Offset command is that you only need provide the distance to the duplicate object. No direction is supplied as the direction is always perpendicular to the angle of the original object.

The concept of a parallel copy is better seen with objects like arcs (**A**) and circles (**C**). When an arc or circle is offset, the resulting object radius is increased or decreased by the offset distance. The center point remains the same.
Breaking Objects

The Break command is used to create a gap in an object or remove a portion at the end of the object. Unlike the Trim command, the Break command does not require an intersecting cutting edge.

The Break command has a few options and menu selections that shortcut to the options.

Typically the spot where you choose an object becomes the first break point. Then you select another spot for the second break point.

When you break an arc or circle the gap is create counterclockwise from the select spot and the second point location.

Joining Objects

The Join command, added in AutoCAD 2006, combines a group of objects into a single, unbroken object. Objects that can be joined are Lines, Polylines, Arcs, Elliptical Arcs, and Splines. Objects being joined must be of the same type.

Lines, Arcs and Elliptical Arcs may have gaps between the objects to be joined. Polylines and Splines must be contiguous. Lines being joined must lie on the same plane. Arc and Elliptical Arcs being joined must lie on the same imaginary circle and ellipse respectively.

One of the handy features of Join is that Individual Arcs and Elliptical Arcs can be closed to form circles and Elliptical Arcs respectively. Initially you are prompted:

Select source object:

The properties of the source object will be applied to objects being joined to it. The remaining prompts vary a bit depending on which type of object is being joined. However, essentially you are prompted:

Select ??? to join to source or [cLose]:

--- --- --- --- --- ---

--- --- --- --- --- ---
Adding Fillets

The Fillet command allows you to connect two objects with an arc of a specified radius. A radius of zero may be used to create a sharp corner.

Any combination of lines, arcs and circles can be joined with the Fillet. As long as the Mode is set to TRIM, selected objects will be shortened or lengthened as needed to apply the fillet. If the Mode is set to NOTRIM, the fillet is added, but the selected objects remain unchanged.

Unlike many commands, the Fillet command does not loop, or assume you plan to Fillet multiple pairs of objects. The Multiple option will allow you to select multiple pairs of objects. This option is not permanent and applies only to the current instance of the command.

If the objects selected are two parallel lines, the Fillet command calculates the radius necessary to apply a 180° arc.

Adding Chamfers

The Chamfer command allows you to connect two lines with an angled line. The new line is designated a distances from a corner or a distance and angle from a corner.

Only lines are allowed to be selected with the Chamfer. As long as the Mode is set to TRIM, selected objects will be shortened or lengthened as needed to apply the Chamfer. If the Mode is set to NOTRIM, the Chamfer is added, but the selected objects remain unchanged.

Unlike many commands, the Chamfer command does not loop, or assume you plan to Chamfer multiple pairs of lines. The Multiple option will allow you to select multiple pairs of lines. This option is not permanent and applies only to the current instance of the command.

The Distance option prompts for the first and second chamfer distances. If not equal, the order the lines are selected determine how the distances are applied.

The Angle option prompts for the chamfer distance and the angle from the first chamfer line. The order the lines are selected always determines how the chamfer is applied, unless the angle is 45°.

Using the Properties Palette

The Properties Palette allows you to view and/or change object properties (appearance, size, location, etc.) of selected objects. The Properties Palette can be displayed by pressing CTRL+3. The Properties Palette will also be displayed when you double-click on most objects.

General Properties

General Properties are those properties that are assigned to every object in a drawing.

- **Color** – The color number (or name) assigned to the object. Bylayer means that the object inherits the color of the object’s layer.
- **Layer** – Used to group similar objects. Among other options, layers can be displayed (turned on or off) in various combinations.
- **Linetype** - The name of the dash/dot/space pattern assigned to the object. Bylayer means that the object inherits the linetypes of the object’s layer.
- **Linetype Scale** – A factor applied to the dash/dot/space pattern of the object. Numbers greater than 1 increase the dash/dot/space pattern size. Numbers smaller than 1 decrease the dash/dot/space pattern size.
- **Plot Style** – A property that controls the appearance of the object when plotted.
- **Lineweight** - The width of the object.
- **Hyperlink** – If present and activated, opens another document.
- **Thickness** – a 3D property, similar to extruding the object in the Z direction.
Geometry Properties

Geometry Properties are those properties that define the object. Location, size and object specific properties are types of geometry properties. Below are the Geometry Properties of a Circle, Line and Rectangle.

<table>
<thead>
<tr>
<th>Circle Properties</th>
<th>Line Properties</th>
<th>Rectangle Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Geometry</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Center X</td>
<td>18.6231</td>
<td></td>
</tr>
<tr>
<td>Center Y</td>
<td>8.1088</td>
<td></td>
</tr>
<tr>
<td>Center Z</td>
<td>0.0000</td>
<td></td>
</tr>
<tr>
<td>Radius</td>
<td>2.0264</td>
<td></td>
</tr>
<tr>
<td>Diameter</td>
<td>4.0528</td>
<td></td>
</tr>
<tr>
<td>Circumference</td>
<td>12.7233</td>
<td></td>
</tr>
<tr>
<td>Area</td>
<td>12.9005</td>
<td></td>
</tr>
<tr>
<td>Normal X</td>
<td>0.0000</td>
<td></td>
</tr>
<tr>
<td>Normal Y</td>
<td>0.0000</td>
<td></td>
</tr>
<tr>
<td>Normal Z</td>
<td>1.0000</td>
<td></td>
</tr>
<tr>
<td><strong>Geometry</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Start X</td>
<td>20.3802</td>
<td></td>
</tr>
<tr>
<td>Start Y</td>
<td>4.3779</td>
<td></td>
</tr>
<tr>
<td>Start Z</td>
<td>0.0000</td>
<td></td>
</tr>
<tr>
<td>End X</td>
<td>20.5644</td>
<td></td>
</tr>
<tr>
<td>End Y</td>
<td>7.2157</td>
<td></td>
</tr>
<tr>
<td>End Z</td>
<td>0.0000</td>
<td></td>
</tr>
<tr>
<td>Delta X</td>
<td>6.1742</td>
<td></td>
</tr>
<tr>
<td>Delta Y</td>
<td>2.6379</td>
<td></td>
</tr>
<tr>
<td>Delta Z</td>
<td>0.0000</td>
<td></td>
</tr>
<tr>
<td>Length</td>
<td>6.7142</td>
<td></td>
</tr>
<tr>
<td>Angle</td>
<td>23</td>
<td></td>
</tr>
<tr>
<td><strong>Misc</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Closed</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Linetype generation</td>
<td>Disabled</td>
<td></td>
</tr>
<tr>
<td><strong>3D Visualization</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Material</td>
<td>ByLayer</td>
<td></td>
</tr>
</tbody>
</table>

The properties with the white background can be changed. Those with a gray background are read-only (can be seen, but not changed).

Examining an Object's Properties

To view the properties of an object, the object must be selected and the Properties Palette displayed.

Changing an Object's Properties

To change the properties of an object, the object must be selected and the Properties Palette displayed. Click the desired property and enter a new value. A list of options is available for some properties.

Properties of Multiple Objects

The Properties Palette displays the type of object selected at the top of the palette. If two or more different object types are selected, the drop down value will be (All #), where # is the number of objects selected.

For example, when an arc and circle of different sizes are selected, the Properties Palette looks like that at the right. The General Properties of the two objects are the same, so these values are displayed.

You can examine or change like objects within a group of selected objects by choosing the object type from the type drop down at the top of the palette.
Using Layers to Manage Appearance and Organize Drawings

Each object in an AutoCAD drawing has a group of properties or characteristic that defines the object. Some properties are unique to a particular type of object, like the area of a circle. Other properties, known as General properties, apply to all types of objects. Layer is one such property.

Layer Properties

Assigning different layers to objects allows them to display various colors, linetypes (dashed lines) and lineweights. Most drafting applications use different linetypes and lineweights to call attention to important aspects of a design. Although drawings are occasionally printed in color, the use of color in an AutoCAD drawing is more for identification while drawing, rather printing.

Layer Status Toggles

One or more layers can also be made invisible, hiding those objects assign to the layers. Locking layers prevents objects from being selected, avoiding accidental deletions or movements of objects. For instance, if you are arranging furniture in an existing building, you might want the walls, doors, and windows layers to be locked so you can’t accidentally change these objects.

Turning a Layer On or Off

When a layer is turned off, the objects assigned to that layer are not visible, are not plotted and cannot be selected. The objects will, however, be included in any drawing regeneration. For most people, this means that the objects assigned to Off layers are included in Zoon Extents calculations. Layers can be toggled On or Off by using the Layer Drop Down control. Activate the control (A) and choose the light bulb icon (B) from the list to toggle it on or off. If the light bulb is yellow, the layer is On. If it is gray the layer is Off.

Beginning with AutoCAD 2007+, the LayOff command can also be used to turn off layers. This command prompts you to select objects in the drawing. When completed, the layers assigned to the selected objects are turned Off. The LayOn command is a handy way to turn on all the layers in the drawing.

Frozen/Thawed

A layer may also be frozen. Freezing a layer is just like turning it off, except that objects on a frozen layer will not be included in a drawing regeneration. This means that objects assigned to Frozen layers are not included in Zoom Extents calculations. Layers can be toggled Thawed or Frozen by using the Layer Drop Down control. Activate the control (A) and choose the Sun/Snowflake icon (B) in the second column of the list to toggle it thawed or frozen. If the sun icon is shown, the layer is Thawed. If it appears as a gray snowflake the layer is Frozen.

Beginning with AutoCAD 2007+, the LayFrz command can also be used to freeze layers. This command prompts you to select objects in the drawing. When completed, the layers assigned to the selected objects are Frozen. LayThw command is a handy way to thaw all the layers in the drawing.
Locked/Unlock

A layer may be protected or locked. You can see objects on a locked layer, plot objects on a locked layer, but you cannot select objects on a locked layer. Locking layers is helpful when you need to protect portions of your drawing from accidental changes while still being able to utilize the geometry in your design. Layers can be toggled Unlocked or Locked by using the Layer Drop Down control. Activate the control (A) and choose the padlock icon (B) in the fourth column of the list to toggle it unlocked or locked. An open padlock indicates that the layer is unlocked. A layer is locked when the padlock is closed.

Beginning with AutoCAD 2007+, the LayLck command can also be used to lock layers. This command prompts you to select objects in the drawing. When completed, the layers assigned to the selected objects are Locked.

Layers can be unlocked by using the LayUlk. This command prompts you to select objects in the drawing. When completed, the layers assigned to the selected objects are Unlocked.

Layering Schemes

Building plans and layouts typically place architectural elements on separate layers, ie., walls, doors, windows, columns, panels, electrical, HVAC, etc. These types of drawings may use a simple layering scheme (all wall objects on the same layer) or a very detailed system (interior, exterior, fire-rated walls on different layers). Usually the layers in these types of drawings will use a different color for each element to help the drafter readily identify objects on the screen. The linetype setting for the majority of the layers in a building plan is set to Continuous. Wall layers are often assigned a thicker lineweight than door and window layers.

Part drawings often place objects on different layers based on the linetype the object is to display. Object or contour lines, hidden lines, center lines, sections lines, etc. are placed on different layers to facilitate to assignment of the linetype. Additionally, these layers frequently are assigned different colors. Typically, the thickest lines are contour lines, followed by hidden lines, then center lines.

Creating a Layer

A layer is created by using the Layer command. This command displays a palette that is used to create, modify and manage layers within the current drawing.
Right-click on one of the column titles to display a menu that lets manage column settings, including which columns to display.

The New button creates a new layer in the current drawing.

A new layer (Layer1) is added at the end of the list. The new layer inherits the properties (color, linetype, lineweight) and status (on, off, freeze, thaw) of the layer that was highlighted at the time the New button was selected.

Naming (renaming) a Layer

Although the new layer has been named, it is assumed that the name will be changed, so the layer name edit box is active.

Note: To rename a layer, click on the layer name and press F2.

Changing the Color of a Layer

The color of a layer is changed by clicking on in the Color column of the layer. A Color swatch box is displayed. The box displays 255 index colors to choose from. Each color is identified by a number.

The first seven color numbers also have names.

<table>
<thead>
<tr>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red</td>
<td>Yellow</td>
<td>Green</td>
<td>Cyan</td>
<td>Blue</td>
<td>Magenta</td>
<td>White/Black</td>
</tr>
</tbody>
</table>

After choosing a color, select the OK button.

Suggestions for color selection

Yellow, green and cyan do not show up well on a white background. Blue and darker grays do not show up will on a black background. Color 7 is white on a black background and blank on a white background.

Use bright colors for the important aspects of your design. Use dimmer colors for less important features.

If possible, relate colors to the “real world” features of your drawing. For example: make water lines blue.

In some configurations, color is used to designate plotting parameters (screening, lineweight or color). Changing the color of a layer might have dire consequences in these configurations.
Changing the Linetype of a Layer

The linetype of a layer is changed by clicking on in the Linetype column of the layer. A linetype is a series of dashes, dots and spaces.

Before a linetype can be assigned to a layer or used in a drawing it must be loaded from a linetype library file. Linetypes are defined in a linetype library file. This is a text file with the extension .LIN. The ACAD.LIN file is included with AutoCAD and contains numerous linetypes. AutoCAD LT uses a file named ACADLT.LIN.

To load a linetype, click on the Load button at the bottom of the Linetype Manager.

You may load one or several linetypes. Use the CTRL key to select several linetypes. Use the SHIFT key to select a range of linetypes.

Changing the Lineweight of a Layer

The lineweight of a layer is changed by clicking on in the Lineweight column of the layer. The defined lineweights appear in small window. A setting of Default means that the drawing’s default lineweight is assigned to the layer. The drawing’s default lineweight setting can be changed (affecting all layers using the default lineweight) by using the Lineweight command.

Note: Lineweights will only be visible in the drawing if the LWT button is on. Lineweights plot regardless of the LWT button setting.
Understanding the Current Layer

The Current layer is the layer that is assigned to objects made using a Draw command. Examples of Draw commands include Line, Circle, Rectangle, Mtext and any Dimension command.

The Current layer can be set in a number of ways.

1. The Layer Drop Down control (A) displays a list of layers in the drawing. Activate the control and choose a layer from the list to make it the Current layer.
2. Activate the Layer Properties Manager. Locate the desired layer in the list. Double-click on the layer name. Select OK to exit.

Use the Make Object’s Layer Current (MOLC) command to set the current layer to that of an object you select.

Changing the Layer of an Object

Several methods exist to change the layer of an object or group of objects in a drawing. Two commonly use techniques involve using the Properties Palette and the Layer Drop Down control. To use the Properties Palette, select the object(s) and choose a new layer from the list in the General section of the Properties Palette. To use the Layer Drop Down control, select the object(s) and choose a new layer from the Layer Drop Down control.

Linetype Scaling

Linetype scale refers to the scaling of the dashed line patterns. It can be applied globally with LTSCALE command or to selected objects using the Properties palette.

Global Linetype Scale

The appearance of all linetypes can be adjusted or scaled with the Ltscale (Linetype Scale) command. The Ltscale setting adjusts the length of the dashes and spaces by applying the current value to the linetype definitions.

Entity Linetype Scale

Typically, the entity linetype scale of an object is 1.0. An additional multiplier can be applied to individual, selected objects in the Property palette. This adjustment applies only to the selected objects. If the global linetype scale is 0.75 of the drawing and the entity linetype scale of an object is 0.5, then the linetype definition of is scaled by 0.75 x 0.5, for an effective scaling of 0.375.

Understanding Entity Properties

The appearance (Color, Linetype or Lineweight) of objects in a drawing may be controlled in two ways. The appearance may be linked directly to the property(s) of the object’s layer. When an object inherits a property from a layer, that object’s property is set to Bylayer. An object’s appearance may not be linked to property(s) of the object’s layer. In that case, a specific property value is assigned to the object. You could think of this method as assigning a property ByObject. Note: ByObject is a term the author uses when an object’s property(s) are not set to Bylayer.
**Bylayer**

The setting named **Bylayer** in reference to Color, Linetype or Lineweight means that objects inherit the value assigned to layer of the object. In other words, if an object's color property is set to **Bylayer** and the layer the object is assigned to is Color 1 (Red), then the object appears Red.

If several objects have their setting(s) assigned **Bylayer**, their appearance can be quickly altered by changing the layer definition. For instance, the Text layer is current assigned a lineweight of 0.25, but all the objects are too thin. If all the objects on the Text layer have their lineweight property set to Bylayer, then simply changing the Text layer's lineweight setting to 0.35 will result in all Text layer objects appearing thicker.

**ByObject**

To understand the concept of ByObject, let's examine a small assembly of a Cam, Shaft, Roller and Follower.

This drawing doesn't assign objects to layers based on the intended linetype of the object. Instead, objects are grouped by which component the object is used to depict. Instead of placing objects on different layers to achieve the proper appearance, the properties can be assigned directly to the object.

**Changing the Linetype of an Object**

Several methods exist to change the linetype of an object or group of objects in a drawing. Two commonly use techniques involve using the Properties Palette and the Linetype Drop Down control. To use the Properties Palette, select the object(s) and choose a new linetype from the Linetype list in the General section of the Properties Palette. To use the Linetype Drop Down control, select the object(s) and choose a new linetype from the Linetype Drop Down control.

In the figure at the right, the linetype of the lines labeled A has been changed to CenterX2 and the arc labeled B has been changed to HiddenX2.

What are linetypes CenterX2 and HiddenX2? The eight basic linetypes have two variations each. In one variations the dashes, and spaces are ½ the size of the Basic linetype and in the other the dashes and spaces are 2x the size of the Basic linetype.

<table>
<thead>
<tr>
<th>Basic Name</th>
<th>Sample Pattern</th>
<th>½ Name</th>
<th>2x Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Border</td>
<td>__ · __ · __ · __ · __ · __ · __ · __</td>
<td>Border2</td>
<td>Borderx2</td>
</tr>
<tr>
<td>Center</td>
<td>__ · __ · __ · __ · __ · __ · __ · __</td>
<td>Center2</td>
<td>Centerx2</td>
</tr>
<tr>
<td>Dashdot</td>
<td>__ · __ · __ · __ · __ · __ · __ · __</td>
<td>Dashdot2</td>
<td>Dashdotx2</td>
</tr>
<tr>
<td>Dashed</td>
<td>__ · __ · __ · __ · __ · __ · __ · __</td>
<td>Dashed2</td>
<td>Dashedx2</td>
</tr>
<tr>
<td>Divide</td>
<td>__ · __ · __ · __ · __ · __ · __ · __</td>
<td>Divide2</td>
<td>Dividex2</td>
</tr>
<tr>
<td>Dot</td>
<td>__ __ __ __ __ __ __ __ __ __ __ __ __</td>
<td>Dot2</td>
<td>Dotx2</td>
</tr>
<tr>
<td>Hidden</td>
<td>__ __ __ __ __ __ __ __ __ __ __ __ __</td>
<td>Hidden2</td>
<td>Hiddenx2</td>
</tr>
<tr>
<td>Phantom</td>
<td>__ __ __ __ __ __ __ __ __ __ __ __ __</td>
<td>Phantom2</td>
<td>Phantomx2</td>
</tr>
</tbody>
</table>
**Changing the Lineweight of an Object**

The same methods exist to change the lineweight of an object or group of objects in a drawing. To use the Properties Palette, select the object(s) and choose a new lineweight from the Lineweight list in the General section of the Properties Palette. To use the Lineweight Drop Down control, select the object(s) and choose a new lineweight from the Lineweight Drop Down control.

In the figure at the right, the lineweight of the lines labeled A has been changed to 0.18 and the arc labeled B has been changed to 0.25.

---

**Changing the Lineweight of an Object**

The same methods exist to change the color of an object or group of objects in a drawing. To use the Properties Palette, select the object(s) and choose a new color from the Color list in the General section of the Properties Palette. To use the Color Drop Down control, select the object(s) and choose a new color from the Color Drop Down control.
**Layout Features**

A *Layout* is a separate tab or view that allows you to create a presentation for a *model*. The model is the 2 or 3 dimensional representation of the object you are drawing. The model can be a building, a single component or an assembly. Actually, the model is anything that you can draw that has measurable size.

To communicate your design to others, the model information needs to be organized and arranged on a sheet of paper. This sheet of paper is a *Layout*. A drawing file may contain one or more layouts. Each Layout can depict a different portion or view of the model. The *Layouts* may be same or different size sheets. The paper size and printing parameters for each *Layout* are unique.

A *Layout* allows you to present your design at different scales simultaneously, both on the same sheet or on different layouts. Various design elements can be hidden or displayed in a different color.

**Layout Display Options**

The *Display* tab of the *Options* command contains several controls related to Layouts.

- **Display Layout and Model Tabs**
  Turn on to use Excel like tabs to navigate between layouts. Turn off to use Quick Layout View to navigate between layouts.

- **Display printable area**
  Turn on to display dash line representing the printable area of the layout. Dependent on selected printer.

- **Display paper background**
  Turn on to display the paper and desktop in two colors.

- **Display paper shadow**
  Turn on to display the paper shadow.

- **Show Page Setup Manager for New Layouts**
  Turn on to use the Page Setup Manager to specify printer, page size, orientation, plot style, etc. when defining a new layout. Turn off to use the default settings.

- **Create viewport in new layouts**
  Turn on to automatically create a viewport in new layouts. Viewport will be created on the current layer approximately 1” from the printable area edge.
Creating Layouts

A new, blank sheet is added by using **Layout** command. Depending where you select the command, you may be prompted for a layout name. Otherwise, the layout will be assigned the name Layout#. Layout1 and Layout2 that are typically present are new layouts.

Layouts can also be inserted into the current drawing, bringing in printing parameters, such as printing device and paper size, as well as title block information. The Design Center palette is an easy way to insert layouts defined in other drawings.

Configuring a Page Setup

While a drawing file may contain many Layouts, each one is independent with its own properties. The printing related parameters of a layout are grouped as a **Page Setup**.

Page Setups are created and modified using the **Pagesetup** command. By default, a Page Setup exists for each Layout in a drawing. The names of these Page Setups appear in the Page Setup Manager with asterisks before and after the Layout name. Example: *Layout1*.

In addition to the default Page Setups, you can create **Named Page Setups** that can be referenced by any layout in the drawing. Page Setups can also be imported from other drawings. Named Page Setups are very useful when different printing parameters are used for the same layout. For instance, large sheets are often printed at a reduced size for reference. Two Named Page Setups can be created, one for a normal size print, the other for the reduced print. All of the parameters are changed simply by selecting one of the Page Setups.
Setting Up Viewports

A viewport is like a window in the paper, allowing you to display the model along with title blocks, charts and notes.

Creating a Viewport

Viewports are created with the VPORTS command. The Viewport Window contains several selections on the New Viewports tab. To create just one viewport, select Single in the Standards viewports: list. Next, pick the OK button. When prompted to select corners of the viewport, pick two points to define the size and location of the viewport.
Resizing the Viewport

The area of the model being displayed can be changed by increasing or decreasing the viewport size. The viewport is a paper space object, so you must be in Paper Space to make any changes to it.

To change the size of a viewport, you first must select it. Four blue boxes (grips) control the location and size of the viewport.

To resize a viewport, click inside a blue box (grip). Move your pointer to a new location and left click. Press ESC to clear the selection.

If you make the viewport smaller, the model space objects will appear cropped.

Paper Space vs Model Space

Before you can draw or edit objects using the layout mode, you must learn which objects are in Paper Space and which objects are in Model Space.

You can determine if you are on in Paper Space by looking for the indicators on the screen.
The easiest way to switch to Model Space is to double-click within the boundaries of a viewport. To switch to Paper Space, double-click outside the boundaries of all viewports.

### Setting Viewport Scales

In most design disciplines a scale is used to relate the size of the model on the sheet of paper to the actual object. Scale is a property of a viewport. The scale of a viewport can be changed by using the Viewport Scale control in the tray.

To change a viewport's scale, double-click inside the viewport and then choose the desired scale in Viewport Scale control in the tray.

### Zooming/Panning and Viewports

Because zooming and panning will disturb your carefully composed sheet of paper, you will want to prevent unintentional changes to the appearance of your viewport images. You can Lock the viewport display to prevent zooming and panning within the Model Space viewports on a layout.

Positioning the Model Within the Viewport

To position the image within the viewport you should PAN the model, not MOVE the objects. Moving the objects would likely change the appearance of other layouts in the drawings.

The display in a viewport is usually locked, to prevent intentionally changes to the sheet presentation. If so, the viewport will need to be unlocked, panned and then relocked. Locking and unlocking a viewport display is a viewport property.

### Locking the Viewport Display

Once you have scaled and positioned the image within the Viewport, you should Lock the viewport image. This prevents you from accidentally repositioning the image within the viewport while drawing or modifying the model.

To lock the Viewport Display, activate the viewport and click on the padlock icon. Make sure you select the Lock/Unlock Viewport Padlock button and not the Toolbar locking button.
Intro to Plotting

Printing (plotting) an AutoCAD drawing is not quite as simple as printing a word processing document. For instance, word processing documents are mostly printed on a Letter size (8 ½” x 11”) sheet of paper. Engineering documents are printed on a variety of paper sizes. Images in engineering documents are often depicted smaller or larger than actual size to fit properly on a sheet of paper, while elements of a word processing document are shown at finished size. Specific areas of an AutoCAD drawing might be printed where certain pages of a word processing document might be printed. In general, there are more variables to be addressed when printing an AutoCAD drawing.

While the Print window contains a lot of options, the basic ones you need to be concerned about are:

- Plot Configuration
- What to Plot
- Paper Size
- Scale
- Plot Styles
- Orientation

Plot Configuration

The Plot Configuration is the device and its related settings. When you choose a different Plot Configuration all the parameters in the Plot Window will change, so it is best to choose your Plot Configuration first. In a class setting a plot configuration that creates a PDF or DWF file is often used to conserve paper simulating the plotting process.

What to Plot?

A design in AutoCAD can be presented or viewed in several different ways. You may have noticed a number of tabs near the bottom of the AutoCAD drawing window. These tabs are called Layouts. One of the Layouts is named Model. The Model layout is the area where all elements of the design are present in 3D space. The remaining Layouts can be thought of as different sheets of paper used to depict all or part of the design.

Some people use only the Model tab for design work and printing and include a title block in this drawing area. When printing from the Model tab you will need to know the intended drawing scale or fit the image to the page. Printing a Layout is a bit more like printing a page from a word processing document, the parameters should already be set and you are ready to go.

Once you’ve decided to print from the Model tab or a Layout tab, you need to determine the Area of the tab (space) that you intend to print: Window, Extents, Display, View, Limits (Model tab only) or Layout (Layout tabs only).

- **Window**
  The Window option allows you to choose an area to plot by designating a window. Use this when you want a print of a portion of the design.

- **Extents**
  The Extents of the drawing is the smallest box that encompasses all objects on layers that are thawed. This option is commonly used to print from the Model tab or to print a Layout tab to Fit on a sheet of paper.

- **Display**
  The Display option is simply what is visible in the drawing area right now, including the empty space from the Extents of the object to the edge of the drawing window.

- **View**
  Prints the area defined by a named view.

- **Limits (Model tab only)**
  Prints an invisible area specified by a lower left and upper right corner in the Limits command.

- **Layout (Layout tabs only)**
  Prints the current layout as designed. What you see is what you get.

Paper Size

The available paper sizes will be determined by the Plot Configuration you selected. Some printers will show an Expanded paper size. An Expanded paper size results in a larger printing area (smaller margin). You may need to manually enable this feature on your device to achieve a successful outcome. Often you will see a wide and narrow version of paper sizes, ie. 8 ½” x 11” and 11” x 8 ½”. If this is the case you will need to figure out which direction (narrow or wide) your printer feeds the paper to determine which setting is correct.
Scale

Scale refers to reduction or enlargement of the image as it is transmitted to the printer, like on a copier. This can be tricky and depends on a number of factors. More care needs to be taken when choosing a scale when plotting from the Model tab. If you are printing a drawing with a title block, you will need to know what the intended scale is. You may be able to determine this by looking at the title block. Otherwise, you can choose the Scale to fit option. The chart below provides some typical choices for both Model and Layout printing.

Plot Styles

The appearance of your drawing when printed can be determined by the properties (Color/Lineweight) assigned in the drawing or at the time it is plotted. To change the appearance of your drawing when plotted, a Plot Style Table is created/assigned to your layout. The Monochrome Plot Style Table supplied with AutoCAD is used to force all the drawing colors to black at the printer.

Orientation

Orientation is simply the choice between Portrait or Landscape. The choice here is dependent on your device and your drawing.

Plot Window Organization

The Plot Window format tends to change somewhat from version to version, but the information is simply moved around a bit. In AutoCAD 2000-2004 the Plot Window organized settings are two separate tabs. From AutoCAD 2005+ a detail button in the lower right corner is used to see more settings.

Creating Single Line Text

The Dtext command creates single line text that is dynamically displayed on the screen as you type it. It is commonly used in balloons or for titles. The command can be found in the Text toolbar or Draw > Text menu. You can also execute the Dtext command by typing DTEXT and ENTER or using the shortcut key DT and ENTER.

To create single line text using Dtext, first choose the command. Next, select an insertion (placement) point to locate the text. The current text height will be displayed as a default value. Press ENTER to accept the value or type a new number and press ENTER. Use the same procedure to accept or change the rotation angle. After all these parameters are dealt with, you can begin typing the text. Press ENTER when you have typed a complete line of text. The cursor advances downward (assuming the rotation angle is 0) and you may type another, separate line of text. When you have input all the desired text, press ENTER on last time when the cursor appears in a new, empty location.
Single line text may be aligned to the insertion point in many different ways. The figure below shows most of the available alignments. A dot indicates the insertion point of each text object.

<table>
<thead>
<tr>
<th></th>
<th>Left</th>
<th>Center</th>
<th>Right</th>
</tr>
</thead>
<tbody>
<tr>
<td>Top</td>
<td>Single line text</td>
<td>Single line text</td>
<td>Single line text</td>
</tr>
<tr>
<td>Middle</td>
<td>Single line text</td>
<td>Single line text</td>
<td>Single line text</td>
</tr>
<tr>
<td>Bottom</td>
<td>Single line text</td>
<td>Single line text</td>
<td>Single line text</td>
</tr>
</tbody>
</table>

The alignment or justification is set before choosing the insertion point of single line text. After selecting the command, choose the justification by right-clicking and select Justify from the menu. Then right-click and select the desired justification from the menu. As always, you can type J and press ENTER and then type the option keyword followed by ENTER.

**Editing Single Line Text**

To edit a single line text object double-click the edge of one of the letters of the text. You can also choose the Edit... command from the Text toolbar and select the text object on the edge of one of the letters.

All of the characters in the single line text object will highlight, indicating that any new text you type will replace the characters. To make an addition, place your pointer in the desired location and click. Although several lines of text may be created with one use of the Dtext command, the resulting lines of text are separate objects.
Creating Multiline Text

The `Mtext` command creates paragraphs that fit within a nonprinting text boundary.

Properties like wrapping, justification, style, height, rotation, width, color and spacing can be controlled in the In-place Text Editor below or the contextual ribbon panel.

**Contextual Ribbon Panel**

![Contextual Ribbon Panel Diagram]

Note: The second toolbar row and display menu options button were added in AutoCAD 2006. To access these features in older versions, right-click within the text editor area.

**Wrapping**

Each multiline text (`mtext`) object is a single object, regardless of the number of lines it contains.

![Boundary Box Diagram]

All outlets to be located 14" from floor

**Text Styles**

All text objects, attributes and dimensions have an
associated text style. AutoCAD provides a default text style, Standard. If you want additional text styles, you must create them. Creating Text Styles is not addressed in the explanation.

Each Text Style has a group of properties. The most visible property of a text style is the Font File assigned to the style. Mtext objects may use Text Styles to control the appearance of the characters or they may use Fonts Files. Be careful assigning Font Files directly to an Mtext object. To later change the appearance of the text objects, you will have to edit it individually and manually. Using Text Styles to control the appearance lets you globally change the appearance of text by altering the Text Style.

The Text Style control is the first drop down in the Text Formatting toolbar (shown when the In-place Text Editor is open). The next drop down is the Font File control.

A Text Style (or Font File) may be assigned to the entire text object by selecting the desired values before typing text in the editor. Existing characters may be changed to a different Text Style (or Font File) by highlighting the desired characters and choosing the preferred setting from the drop down.

determined the proper text size for drawings is not addressed in the explanation. The preview in the editor may be erratic when establishing a new text height that varies substantially from the current size.

To enter a text size before entering the In-place Text Editor, begin the Mtext command as you normally would. Next, click the first corner of the boundary box. Before selecting the other corner, right-click and select Height from the menu or type H and press ENTER. Next, type in the desired text height and press ENTER or choose a point to indicate the text size. The height becomes the default text size after you complete the Mtext command.

The current Text Style, the default style when creating new text, can also be set using the Styles toolbar.
Text Justification

Text Justification refers to how the characters are positioned within the bounding box. Horizontal settings (left, center and right) are combined with the vertical settings (top, middle and bottom) to produce nine different justifications. The justification options can be selected from the Text Formatting toolbar, or the Options menu.

AutoCAPS

Most technical drawings use upper case letters. You can make sure that any text entered in the In-place Text Editor is capitalized by activating the AutoCAPS function. This setting is saved in the system configuration and only needs to be activated once. The AutoCAPS setting is found in the Options menu.

Text can be made upper or lower case using the button in the toolbar.

Editing Multiline Text

Mtext objects can be modified by double-clicking on the object or left-clicking on the Mtext object and then right-clicking and selecting Mtext Edit... from the menu.
Annotative Objects Concepts

One of the most challenging tasks for many AutoCAD users has been determining the size of annotation elements of the drawing. Annotation elements are objects that are not actually part of the design, but describe the design. Text, Dimensions, Hatches and Symbols (usually Blocks) are typical annotations. The size or scale of these elements is dependent on the scale that the design is presented on a sheet of paper.

AutoCAD 2008 introduced the concept of Annotative Objects. An Annotative Object is defined at paper height or size. When used in a drawing, an Annotative Object is displayed at the sized determined by the current annotation scale. Objects that may have an Annotative property are: Text, Dimensions, Tolerances, Blocks, Attributes, Hatches and Leaders created with the Mleader command. Most Dialogs and Palettes related to the creation and editing of these objects will contain a control to change the Annotative property of the object. Additionally, when your cursor hovers over and Annotative Object a triangular icon is displayed. If an object supports (displays at) more than one scale a double triangular icon is shown.

Annotative Styles

The most effective way to deal with Text, Dimensions and Multileaders is with Annotative Styles. The dialog boxes that managed these styles include a check box where you can enable the Annotative property. In general, specify heights and sizes in these styles in terms of Paper size. The current Annotative Scale will size the objects to properly display at the designated Paper size.

Annotative Text

To create Annotative text, make the Annotative text style current. The current text style can be set in the Styles toolbar, Annotate ribbon tab or Text Editors.
Understanding Dimensions - Basic

Most technical drawings will require at least a few dimensions. AutoCAD includes several commands that create, modify and manage dimensions.

It is important to remember that dimension commands produce a single object, not a bunch of unrelated lines and text. Dimensions are linked to the points or objects being measured. Dimensions are complex objects, that when properly managed, update when the objects they are associated with change. This association between objects and dimensions can save a great deal of time when drawings are updated and revised.

Because dimensions are more complex than, say lines, there are special commands and techniques for making modifications. Altering dimensions as though they were primitive objects will likely break the link to their associated objects.

Various parts of a dimension object are referred to by specific names. Knowing these names will make it easier to create, modify and manage dimensions in your drawing.

Linear Dimensions

The Dimlinear command measures the distance between two points in a straight line and places a dimension in the drawing.

Dimension Basics

It is important to remember that dimension commands produce a single object, not a bunch of unrelated lines and text. Dimensions are linked to the points or objects being measured. Dimensions are complex objects, that when properly managed, update when the objects they are associated with change. This association between objects and dimensions can save a great deal of time when drawings are updated and revised.

Because dimensions are more complex than, say lines, there are special commands and techniques for making modifications. Altering dimensions as though they were primitive objects will likely break the link to their associated objects.

Parts of a Linear Dimension

Various parts of a dimension object are referred to by specific names. Knowing these names will make it easier to create, modify and manage dimensions in your drawing.
Creating a Linear Dimension

After choosing the **Dimlinear** command, you must choose the two points to measure between. These are known as the extension line origins. You can specify two points (A and B), usually with an Osnap, or you can choose an object.

When specifying the measurement points by selecting an object, type of object selected determines which points on the object will be used for the measurement. In the case of a line (A), the endpoints will be used.

Note that the default method is to choose two points. You must press **ENTER** at the Specify first extension line origin or <select object>: to use the select object method.

Once the measurement points are determined, the dimension must be located. A horizontal or vertical measurement is implied based on your dimension line location position (B in lower figure and C upper figure).

Modifying a Linear Dimension

The position of various elements of a Linear Dimension can be altered by changing the location of one or more control points (grips) of the dimension. To change a location, click on the dimension and release the mouse button. Click on the desired control point (grip) and release the mouse button. Move your cursor to the new position, click and release the mouse button.

A – Changes the location of the dimension text. May change the position of the dimension line if the dimension properties are set to Move with dimension line.

B – Changes the location of the dimension text and dimension line.

C – Changes the location of the extension lines origin. Changes the numeric value of the dimension text. Breaks the link between the dimension and the points on the object being measured.
Radius Dimensions

The Dimrad command measures the radius of an arc or circle and places a dimension in the drawing. The letter R prefix is added to the dimension text.

Dimension Basics

It is important to remember that dimension commands produce a single object, not a bunch of unrelated lines and text. Dimensions are linked to the points or objects being measured. Dimensions are complex objects, that when properly managed, update when the objects they are associated with change. This association between objects and dimensions can save a great deal of time when drawings are updated and revised.

Because dimensions are more complex than, say lines, there are special commands and techniques for making modifications. Altering dimensions as though they were primitive objects will likely break the link to their associated objects.

Parts of a Radius Dimension

Various parts of a dimension object are referred to by specific names. Knowing these names will make it easier to create, modify and manage dimensions in your drawing.

Creating a Radius Dimension

After choosing the Radius Dimension command, you must choose the arc or circle to measure. You must place your cursor on the arc or circle (A) and click.

Next you will choose the Dimension line location. This is actually the end of the hook line (B) between the leader and the dimension text. If you press ENTER in response to the request for the Dimension line location, a default leader will be drawn. If you place the Dimension line towards the inside of an arc, an Arc Extension Line will be drawn.
Modifying a Radius Dimension

As with a Linear Dimension, the position of various elements of a Radius Dimension can be altered by changing the location of one or more control points (grips) of the dimension. To change a location, click on the dimension and release the mouse button. Click on the desired control point (grip) and release the mouse button. Move your cursor to the new position, click and release the mouse button.

A – Rotates the leader line and dimension text about the center of the arc or circle. The arrow will not be placed beyond the ends of the arc.

B – Changes the location of the dimension text. Also changes the position of the leader.

C – Changes the location of the extension lines origin. Changes the numeric value of the dimension text. Breaks the link between the dimension and the object being measured.

Diameter Dimensions

The DimDia command measures the diameter of an arc or circle and places a dimension in the drawing. A diameter symbol prefix is added to the dimension text.

Dimension Basics

It is important to remember that dimension commands produce a single object, not a bunch of unrelated lines and text. Dimensions are linked to the points or objects being measured. Dimensions are complex objects, that when properly managed, update when the objects they are associated with change. This association between objects and dimensions can save a great deal of time when drawings are updated and revised.

Because dimensions are more complex than, say lines, there are special commands and techniques for making modifications. Altering dimensions as though they were primitive objects will likely break the link to their associated objects.

Parts of a Diameter Dimension

Various parts of a dimension object are referred to by specific names. Knowing these names will make it easier to create, modify and manage dimensions in your drawing.
Creating a Diameter Dimension

After choosing the Diameter Dimension command, you must choose the arc or circle to measure. You must place your cursor on the arc or circle (A) and click.

Next you will choose the Dimension line location. This is actually the end of the hook line (B) between the leader and the dimension text. If you press ENTER in response to the request for the Dimension line location, a default leader will be drawn.

Modifying a Diameter Dimension

As with a Linear Dimension, the position of various elements of a Diameter Dimension can be altered by changing the location of one or more control points (grip) of the dimension. To change a location, click on the dimension and release the mouse button. Click on the desired control point (grip) and release the mouse button. Move your cursor to the new position, click and release the mouse button.

A – Rotates the leader line and dimension text about the center of the arc or circle. The arrow will not be placed beyond the ends of the arc.

B – Changes the location of the dimension text. Also changes the position of the leader.

C – Changes the location of the extension lines origin. Changes the numeric value of the dimension text. Breaks the link between the dimension and the points on the object being measured.
Center Marks

The **Dimcenter** command draws two or six lines indicating the center of an arc or circle.

Creating Center Marks

Both the Radius and Diameter dimensions typically include a center mark or center line. To place a mark at the center of an arc or circle without a Radius or Diameter, use the Center Mark command. This command simply prompts you to select an arc or circle. The Center Mark is made up of lines.

Formatting Center Marks

The Center Marks created in the Diameter, Radius and Center Mark commands can be formatted as a Mark, Line or None.

The size of the Mark and the distance the Line extends beyond the arc or circle can also be controlled.

The Dimension Style Manager command is used to control the appearance of dimensions. You can control the appearance of dimensions by changing settings. For convenience and to help maintain dimensioning standards, you can store these settings in dimension styles.

By modifying a dimension style, you can update all existing dimensions created previously with that dimension style to reflect the new settings. To change the format of the Dimension Style assigned to the dimensions, select Dimension Style.

The **Modify** button allows you to change the highlighted Dimension Style. Any dimensions assigned to that Dimension Style will inherit those changes, unless settings (overrides) have been specifically applied to the dimension. Note that only Center marks incorporated with Radius and Diameter dimension will be updated. The Center mark command creates Lines and which are not linked to a Dimension Style.

To change the extension gap distance, select the **Modify** button and the Symbols and Arrows tab.

Select the type of **Center mark** (None, Mark or Line).

Use the number box to change the size of the **Mark** or the distance the Line extends beyond the arc or circle.

For the change to be applied to the dimensions, the **OK** button is selected. Then the **Close** button is picked to complete the changes to the Dimension Style.
Angular Dimensions

The Dimang command measures the angle between three points and places a dimension in the drawing, creating an Angular Dimension.

Creating an Angular Dimension

After choosing the Dimang command, you must choose the objects that define the three points used to compute the measured angle or choose three specific points. The default option is to choose objects.

The most common method of adding an Angular dimension is to choose two lines (A and B) and then locating the dimension (C). The vertex of the measured angle is the implied intersection of the two selected lines. The other ends of the lines provide the points to complete the angle. When measuring an angle designated by two lines, the result will always be less than 180°.

You can also create an Angular dimension by selecting an arc (A) and then locating the dimension (B). The vertex of the angle is the center of the arc. The ends of the arc provide the points to complete the angle.

To specify the three points instead of choosing objects, you will need to press ENTER when prompted to Select arc, circle, line, or <specify vertex>: Then you will select the vertex point (A) and the two angle end points (B and C). The measured angle will be one of two angles whose sum equals 180°. The location of the dimension lines determines which angle is used.

Modifying an Angular Dimension

As with the other Dimensions, the position of various elements of an Angular Dimension can be altered by changing the location of one or more control points (grips) of the dimension. To change a location, click on the dimension and release the mouse button. Click on the desired control point (grip) and release the mouse button. Move your cursor to the new position, click and release the mouse button.

A — Changes the location of the dimension text. May change the position of the dimension line if the dimension properties are set to Move with dimension line.

B — Changes the location of the extension lines origin. Changes the numeric value of the dimension text. Breaks the link between the dimension and the points on the object being measured.

C — Changes the location of the vertex. Changes the numeric value of the dimension text. Breaks the link between the dimension and the points on the object being measured.

D - Changes the location of the dimension text and dimension line.
Controlling Numbers in Dimensions

The way a dimension looks is controlled by two things: a dimension style and the properties assigned to the object. To maintain a consistent appearance, dimensions should rely primarily on a dimension style. Object properties should be changed only when an oddball situation occurs. This is an overview of some of the more common dimension properties.

Dimension Styles are created and managed in the Dimensions Style Manager. This command can be found in the Dimension toolbar or menu. You can also execute the Dimensions Style Manager by typing `DIMSTYLE` and `ENTER`.

The Dimensions Style Manager opens a dialog that allows you to create or modify Dimension Styles. A Dimension Style is a group of dozens of properties that determine what dimension look like and how they behave. A preview of the highlighted dimension style is displayed.

Choosing the New… or Modify… buttons displays a dialog box with several tabs. The similar settings are organized in the Dimensions Style Manager on separate tabs. Modifying a dimension style will change the appearance of objects assigned to that dimension style.

Global Primary Units Changes

The Unit format and precision of dimensions is controlled on the Primary Units tab. All dimensions use the Linear dimensions setting except angular dimensions.

Several other number formatting options are available. When using a unit format containing fractions, you may choose between a horizontal or diagonal fraction. Leading and/or trailing zeros may be suppressed in decimal formats, while zero feet and/or inches suppressed formats that express number as feet and inches. Prefixes and suffixes may also be added to the number.
Unit Formats and Precision

The Linear dimension unit formats are similar, but not the same as the units setting available drawing. Keep in mind that the dimensions are formatted with an eye toward the method of manufacture, materials and expectations of the end user.

**Linear Dimensions**

Below are the selections available for Linear dimensions (all non-angular dimensions).

- Decimal
- Engineering
- Architectural
- Fractional

**Angular Dimensions**

Below are the selections available for Angular dimensions.

- Decimal Degrees
- Degrees – Minutes - Seconds
- Radians
- Grads
- Surveyor’s Units

Changing a setting of a Dimension Style in the Dimension Style Manager will automatically update dimensions belonging to the style.

For instance, to change all the dimensions belonging to the Standard style to 3 decimal places, change the precision setting on the Primary Units tab.

---

**Object Specific Primary Units Changes**

The **Precision** property dictates the maximum number of decimal places to be displayed. This setting can be overridden on a dimension by dimension basis.

Just select the desired dimensions and right-click to display a menu.

Click **Precision**, then the desired precision.
Using Leaders

The **Leader** command creates leader objects. An arrow is placed at the start point of a leader and text or other annotation at the end of the leader hook line. The hook line is a short, horizontal line automatically placed at the specified end point of the leader. The Leader command uses the properties of the current Dimension Style for Text Height, Arrow Size, etc.

The Leader command is the oldest command that creates leader-like objects. All interface with the command is via the command window. After selecting at least a start point and next point a list of options are displayed in the keyword list.

### Annotation

Begin typing the text associated with the leader or press **ENTER** to choose among a list of Annotation **options**.

**Tolerance**

Displays the Geometric Tolerance symbol window.

**Copy**

Select an object in the drawing to copy and associate with the leader.

**Block**

Type the name of a block to associate with the leader.

**None**

Place nothing at the hook line end of the leader.

**Mtext**

Activate the Multi-line Text Editor to associate text with the leader.

### Format

**Spline**

Use a spline or curved leader.

**Straight**

Use a straight leader.

**Arrow**

Use an arrow.

**None**

Do not use an arrow.
Using QLeaders

The Qleader command creates leader objects. An arrow is placed at the start point of a leader and text or other annotation at the end of the leader hook line. The hook line is a short, horizontal line automatically placed at the specified end point of the leader. The Qleader command uses the properties of the current Dimension Style for Text Height, Arrow Size, etc.

Unlike the Leader command, the Qleader command controls various properties through a Settings dialog box that can be requested at the beginning of the command.

Creating a Leader with Mtext

To create a leader with an Mtext object, select the Qleader command. Before choosing a start point for the leader, right-click and choose Settings from the menu. Click the Annotation tab. Make sure Mtext is selected in the Annotation Type area. When Mtext is the Annotation Type, various options become available. You can choose whether or not the Qleader command will prompt you for the width of the boundary box of the Mtext object. This will determine whether or not the Mtext will wrap. Other options include setting the Mtext to Always left justify and drawing a placing a Frame around the text.

Managing the Leader and Arrow Properties

The Leader Line & Arrow tab includes options to change the appearance of the Leader Line and Arrowhead as well as the number and angle of the leader segments.
Controlling the Multi-line Text Attachment

When Mtext has been selected as the Annotation Type the Attachment tab will be visible. The tab lets you control how the Multi-line text is aligned to the hook line of the leader.

Using Multileader

The Mleader and Qleader (AutoCAD 2008+) commands create leader objects.

An arrow is placed at the start point of a leader and text or other annotation at the end of the leader hook line. The hook line is a short, horizontal line automatically placed at the specified end point of the leader. Leaders can be added with one, none or several lines of text.

The appearance of Multileaders is controlled through the Multileader Style Manager dialog box or command line Options that can be requested at the beginning of the command.

Multileader supports the addition of multiple leaders to the same annotation, alignment of leaders and collection of identical annotations.

The Leader palette includes several samples of multiline leaders with blocks as annotation.
The Trim and Extend Commands

The Trim command clips selected objects based on intersections or extended intersections with other objects in the drawing.

The Extend command lengthens objects based on intersections or extended intersections of objects.

The key to both commands is to identify the intersecting objects. Trim and Extend are powerful, useful commands, but they often confuse new users. The first task after choosing either command is to select the intersecting objects, not the objects being trimmed or extended. The intersecting objects in the Trim command are commonly referred to as cutting edges, while in the Extend command they are called boundaries.

Trimming

To trim one or more objects select the Trim command. Next click on the object(s) to be used as cutting edges. Press ENTER when finished selecting cutting edges. Then click on the objects to be trimmed. The object will be clipped on the same side of the cutting edge as your selection point.

Take this figure. Rectangle A is selected as the cutting edge. Since it is a rectangle, the cutting edge intersects lines B and C twice each. B is the selection point to trim the first line. The second line is selected a C. The portion of the lines remaining after trim is indicated as a thicker edge.

Extending

To extend one or more objects select the Extend command. Next click on the object(s) to be used as the boundaries. Press ENTER when finished selecting the boundaries. Then click on the objects to be extended. If a boundary is found in the direction implied from the midpoint of the object to the selection point, the object will be extended.

Take the same figure. Rectangle A is selected as the cutting edge. Since it is a rectangle, the boundary provides an intersecting edge at both ends of the interior line. Selection point to the right of the midpoint extends the line to the right until it intersects with the rectangle (B). Selecting the line to the left of midpoint extends the line to the left (C). The portion of the line added after extend is indicated as a thicker edge.

Another confusing aspect of the Trim and Extend command is that the intersecting objects can be altered as long as they intersect other selected objects. For instance, if all the objects in figure on the left were selected as cutting edges and selected at the dots to be trim, the result would be the figure on the right.

Selection Options

AutoCAD 2006 added options to select trimmed objects using a Crossing Window and to Erase objects while in the Trim command. Also, previously supported hidden options, such as Fence and Select All are now included in the prompts.
Crossing Windows are implied when you pick the second point to the left of the first point. AutoCAD 2006 displays a Crossing Window filled with a light green color and a dashed edge. In the previous figure, rectangle A is the cutting edge. The Crossing Window is implied by selecting B then C.

If all the objects in the drawing are to be considered as cutting edge or boundaries, just respond to the initial Select objects: prompt by pressing ENTER to choose all the objects in the drawing. However, avoid this shortcut in drawings with numerous intersecting objects.

**Stretching Objects**

The **Stretch** command is used to relocate a group of objects while maintaining connections to other objects.

In the figure on the left, the symbol was Moved, on the right, was Stretched.

The **Stretch** command requires you to select objects and supports both noun, verb and verb, noun selection. Objects must be selected using a **Crossing** selection. Remember that a **Crossing** selection is indicated by selecting the first point A to the right of the second point B. All the objects within the selection box will be moved. The objects C and D will be stretched because one control point is inside the selection box and the other is outside. Objects that have only one control point (circles, blocks) are not stretched. For instance, a circle can’t be stretched to an ellipse. These objects will be moved if the control point is inside the selection box. If not, nothing happens, even though the object might be highligh

After the command and objects are selected you will be prompted to select a **Base point**. The base point is typically a point on or near the objects you are moving. After selecting a base point, you will need to choose a **Second point of displacement**. The second point of displacement is the point where the objects are being moved to. Displacement is a fancy way to saying movement. The manner in which you specify the second point of displacement determines how accurately the object is moved. A frequent mistake is to forget to select the Base point. If a dimension is linked to the stretched objects, it will update.
Another method of stretching object is to Grip Stretch them. Grips are little boxes that appear at significant points on objects, including but not limited to the control points. Grips are activated when an object is selected while no command is active. The following figure shows the grips of a line.

To stretch an object once the grips are activated, left one of the control grips, in this case one of the end grips. The grip will turn Red. Release the button, move your pointer and click again. Don’t forget to press ESC to unselect the object.

The color, size and behavior of grips are controlled by selecting Tools > Options > Selection.

**Stretching a Rectangle to the Right**

1. Right-click on the Polar icon or label in the status line.
2. Click 90 from the list.
3. Turn Polar Tracking on by clicking the Polar icon or label in the status line or pressing F10. Note: This is a toggle. Make sure the command line displays the <Polar On> message before continuing.
4. Select the Stretch command.
5. Place your cursor above and to the right of the rectangle and click.
6. Move your cursor down and to the left approximately half way across the rectangle and click.
7. Press ENTER to stop selecting objects.

8. Place your cursor in the drawing and click.

9. Move your cursor directly to the right

10. Move your cursor to the desired and click.
1. Right-click on the Polar icon or label in the status line.
2. Click 90 from the list.
3. Turn Polar Tracking on by clicking the Polar icon or label in the status line or pressing F10. Note: This is a toggle. Make sure the command line displays the <Polar On> message before continuing.
4. Select the Stretch command.
5. Place your cursor above and toward the middle of the rectangle and click.
6. Move your cursor down and to the left approximately outside the rectangle and click.
7. Press ENTER to stop selecting objects.
8. Place your cursor in the drawing and click.
9. Move your cursor directly to the left.
10. Move your cursor to the desired and click.
**Stretching a Figure with Islands**

When a figure contains islands, like the circles below, stretching becomes a bit more complex. The location of the points designating the crossing window are more critical.

Choosing a crossing window with one edge between the circles as shown here results in space between the circles being affected.

On the other hand, if the circles fall inside the crossing window, the space is affected next to the circles.

Of course, some very interesting things happen if the crossing window is not well thought out.

Although four of the circles contact the crossing window, only the two whose center points fall inside it are stretched.
Mirroring Objects

The **Mirror** command is used to create a reflected image of a group of objects. The Mirror command requires you to select objects and supports both noun, verb and verb, noun selection. After the command and objects are selected you will be prompted to **Specify first point of mirror line**. The mirror line is responsible for the location of the new mirrored object, but isn’t an actual line in the drawing. The points on the mirror line are often a midpoint or center point of nearby objects. Next, **Specify second point of mirror line**.

After designating the mirror line, you will be prompted **Erase source objects? [Yes/No] <N>**: Answering **No** to this prompt retains both the original objects and the new mirrored objects, in effect creating a mirrored copy.

The setting **MIRRTEXT** determines whether or not text created as part of the mirror command is reflected or normal. The default setting of 0 is normal, 1 is reflected.

If you respond to the **Erase source objects? [Yes/No] <N>** by answering **Yes**, the original objects will be deleted.

Arraying Objects

The **Array** command is used to create a regular pattern, either rectangular or circular, of an object or group of objects. The Array command displays a dialog boxes where the various options are selected. Two different types of Arrays can be created: **Rectangular** and **Polar**.

The Array command requires you to select objects and supports both noun, verb and verb, noun selection. If you choose the Array command first, you will need to use the Select objects button in the upper right corner of the dialog to dismiss the dialog while you select the objects. The dialog box will automatically reappear once you have finished selecting objects by pressing **ENTER**.

Distances and angle may be input directly into edit boxes, or the appropriate Pick button can be used to choose points indicating the value on the screen. The dialog box will reappear once the value has been acquired.
**Cornerstone Objects**

The objects selected for the Array command are called the Cornerstone objects. The Cornerstone objects are displayed bolder than the other objects in the primitive preview of the proposed Array.

**Positive and Negative Values**

Inputting a Positive or Negative value for distances and angles result in significantly different results. In a Rectangular Array a positive row spacing, creates rows upward from the Cornerstone. A negative spacing results in the rows being created downward. For Columns, a positive spacing creates columns to the right; a negative spacing to the left. For angles, a positive value indicates counterclockwise; negative clockwise.

**Rectangular Arrays**

A Rectangular Array copies objects in a Row and Column Pattern. Options include the number of Rows, number of Columns, Row offset, Column offset and Angle of array.

In this figure a circle has been arrayed.

- Rows: 4
- Columns: 8
- Row offset: 3.0
- Column offset: 4.0

**Polar Arrays**

A Polar Array copies objects Circular Pattern about a center point. Options include the Number of items and Angle to fill.

In this figure a circle has been arrayed using the Center of the large circle as the center point of the Array.

- Number of items: 8
- Angle to fill: 360

There are several methods of specifying a Polar Array:

- Number of items & Angle to fill (calculates Angle between items)
- Total number of items & Angle between items (calculates Angle to fill)
- Angle to fill & Angle between items (calculates Number of items)

Objects may or may not be rotated as copied.

**Original objects**

- 6 items, 360 degrees
- 6 items, 180 degrees
- 6 items, -180 degrees

- Rotated as copied
- Not Rotate as Copied
Scaling Objects

The **Scale** command is used to resize a group of objects. The Scale command requires you to select objects and supports both noun, verb and verb, noun selection. After the command and objects are selected you will be prompted to select a **Base point**. The base point is the point that the grow away from and shrink towards.

After selecting a base point, you will need to **Specify scale factor**. The scale factor is the amount the objects are resized about the base point. Numbers greater that 1 increase the size of the selected objects, while numbers less than one shrink the selected objects.

Reference Lengths

Objects can also be scaled using reference lengths. The default reference length is 1. Reference lengths allow you to change the reference or starting length so that you can match the length of an edge of the objects being scaled with another edge in the drawing.

1. To Scale using a reference length, select the **Scale** command.
2. Choose the objects and press **ENTER**.
3. Select a base point, typically an endpoint, intersection, etc.
4. Use a reference angle line by right-clicking and selecting Reference from the menu or typing **R** and pressing **ENTER**.
5. Choose two points that indicate the edge of the figure to be resized to a specific value (A and B).
6. Type the desired length.
7. Press **ENTER**.

Scaled Copy (AutoCAD 2006+)

Whether you specify a scale factor or use a reference length, you can choose to create a scaled copy of the selected objects. The option to create a scaled copy appears with the prompt to designate the scale factor. You must select the Copy option before inputting the scale factor or reference length.
Rotating Objects

The **Rotate** command is used to revolve a group of objects. The Rotate command requires you to select objects and supports both noun, verb and verb, noun selection. After the command and objects are selected you will be prompted to select a **Base point**. The base point is the point that the objects are moved or pivoted about.

After selecting a base point, you will need to **Specify rotation angle**. The rotation angle is the amount the objects are rotated about the base point. Positive angles are rotated counter-clockwise while negative angles indicate a clockwise rotation.

**Rotated Copy (AutoCAD 2006+)**

Whether you specify a rotation angle or use a reference angle, you can choose to create a rotated copy of the selected objects. The option to create a rotated copy appears with the prompt to designate the rotation. You must select the Copy option before inputting the rotation angle or reference angle.

**Reference Angles**

Objects can also be rotated using references angles. The default reference angle is direction 0. Reference angles allow you to change the reference or starting angle so that you can align an edge of the objects being rotated with another edge in the drawing.

1. To Rotate using a reference angle, select the **Rotate** command.
2. Choose the objects and press **ENTER**.
3. Select a base point, typically an endpoint, intersection, etc.
4. Use a reference angle line by right-clicking and selecting Reference from the menu or typing **R** and pressing **ENTER**.
5. Choose two points that indicate the edge of the figure to be aligned at a specific angle (**A** and **B**).

6. Type the desired direction.
7. Press **ENTER**.
Introduction to Hatch

The Hatch command fills an enclosed area with a pattern. It lets you define the closed boundary(S) to be hatched, the hatch pattern to be used and the scale and rotation of the pattern. An Associative Hatch Pattern updates when the original boundaries change. If you erase one of the original boundaries, the Hatch pattern can not update.

Existing Hatch patterns can be modified by double-clicking the pattern.

The Hatch dialog contains many options for drawing patterns.

Patterns

A predefined pattern may be selecting by left-clicking on the Swatch button, the Pattern Drop Down control or the ellipse (...) button. There are four groups of patterns, ANSI, ISO, Other Predefined and Custom.

Many of the names of the patterns on the Other Predefined tab begin with AR. These patterns are Architectural in nature and are typically used at a scale of 1 or near 1. The remaining patterns and those on the ANSI and ISO tabs, are designed to look correct at scale of 1=1 and must be scaled like any other non-design object. You can use the Relative to paper space option to allow AutoCAD to determine the appropriate hatch scale for the current viewport scale.

Scale and Angle

The Angle and Scale of the pattern may be selected from the appropriate Drop Down controls. If the desired value doesn't appear in the list, you may input it manually in the boxed area of the Drop Down control. The pattern swatch displays the pattern at angle 0.

Boundaries

The boundaries that define the area to be hatched can be selected by choosing Pick points within a closed space or by selecting objects that enclose a space. The Hatch dialog is hidden while the boundary selection is made.
Separate Hatches

When multiple internal points are selected in a hatch operation, the hatched areas are one hatch pattern. AutoCAD 2006+ includes an option that allows the areas to be created as separate hatches.

Setting the Hatch Origin

The repeating pattern of a hatch begins by default at 0,0. Your hatch boundary traps on area of the repeating pattern. Sometimes it is helpful to define a different origin for a hatch pattern. AutoCAD 2006+ includes the button which allows you to change the origin of the pattern. The Hatch dialog is hidden while the new origin selection is made.

Islands

Other objects often exist within the Hatch Boundary. These internal boundaries are called islands. By default, these islands are selected when using the Pick point option. Every other space defined by a selected boundary will be hatched. Unwanted boundaries may be removed by using the Remove boundaries button.

In this figure, the pattern boundary was defined using the Pick point method. The dot in the outer right was the Pick point location. All the islands within the boundary were selected and every other boundary area filled. Text objects are considered islands and a space around the text left in the hatch.

Creating Hatches with Invisible Boundaries

Sometimes a hatched area doesn't require a visible boundary. When this situation arises, use a non-plotting layer to create the invisible boundaries. Convoluted areas, like building perimeters, often are difficult to hatch in one step. Creating non-plotting boundaries to break up the space usually solves these types of problems.

The previous figure (left) shows the Earth pattern in a closed space. The ragged, bottom edge is assigned to a layer with the No Plot toggled on. The printed drawing would not show the ragged line (right).
Using Design Center

The Design Center Palette allows you to import content (layers, linetypes, text styles, block definitions, layouts, etc.) contained in other drawings. To create a library for use with DesignCenter, begin a new drawing, save it with a logical name in a shared folder. Insert or create blocks within the drawing. For example: To create a library of motors, begin and save a new drawing named Motor in a folder called Equipment on your company’s server. Insert drawings of motors, creating blocks within the Motor drawing file.

The Design Center palette is divided into three areas: toolbar, content area and tree pane. The Large icon display option allows you to graphically choose the block to insert.

Content Area
The right side of the window is the content area. The content area may display folders, drawings, drawing content, images or icons of block or hatch patterns and custom content.

Tree Pane
The left side of the window is the tree view. The tree view is used to navigate between drives, folders, drawings and web locations. The Tree Pane can be turned off if extra space is needed.

DC Toolbar

The buttons along the top of the Design Center window control the appearance of the elements of the window.

Views
The items or content in Design Center can be viewed in several forms. Use the Views button to change the view of items in the list. Options are Large and Small icons, List and Details.

Preview and Description
The Preview and Description panes can be turned on and off with the Preview and Description buttons Design Center. The figure at the right displays the list view with the panes turned on.

Tree View
The Tree View button toggles the display of the Folder list information.
The Home button causes Design Center to display the contents of your home holder. You can change the home folder by highlighting a folder, right-clicking and selecting Set as Home from the menu. The default Home folder contains several drawing with relate block definitions.

The Favorites button displays the contents of your Favorites Folder. The Design Center folder is automatically added to Favorites.

**Managing the Design Center Palette**

Like all palettes, the Design Center Palette can be docked or hidden.

**Docking and Undocking the Design Center Window**

The Design Center window can float over the drawing area or be docked. To dock the window, left-click and hold along the title bar of the window. Drag the window to the left or right side of the drawing area and release.

To undock the window, left-click and hold along the gripper bar, drag the window into the drawing area and release.

**Hiding the Design Center Window.**

An exciting new feature of AutoCAD 2004 is the ability to Auto-Hide the Design Center window. This feature allows the Design Center window to be *on call*, active when needed, invisible when not. When your pointer moves outside the window, only the title bar is displayed. To activate the window, just move your pointer over the title bar.

**Importing Content**

To import content, use the Tree Pane to locate the drawing with the desired layers, linetypes, styles or block definitions. Open the drawing in the Content Area by double-clicking. Double-click on the content group (layers, linetypes, blocks). Click, hold and drag the desired content into the current drawing. If an existing item is already present in the drawing, the imported content is ignored.

**Using the Insert Window**

When a block definition is dropped into the current drawing, the scale factor defaults to 1 and the rotate angle defaults to 0. The block definition can be imported directly into the Insert Window by double-clicking on the definition in the Content Area. This allows you to specify the scale factor and/or rotation angle of the block.

**Tool Palette Overview**

The Tool Palettes are tabbed areas within the Tool Palette window. Tool Palettes organize Tools. **Tools** are Blocks, Hatches and Commands (AutoCAD 2005+). These can be organized in many ways; by project or type of tool.

Unlike the content in Design Center, items on a Tool Palette may be assigned preset object properties (Layer, Color, Linetype and Lineweight) and other characteristics (scale & rotation angle).

There are many display options for tool palettes and the tools that appear on the palette.

**Tool Palette Locations**

Although menu items may be added to a Tool Palette (2007+), Tool Palettes are not part of the menu. Tool Palettes are stored in the path:

C:\Documents and Settings\LOGIN\Application Data\Autodesk\AutoCAD 200#\R1#.\enu\Support\ToolPalette\Palettes

Where LOGIN is your user login and AutoCAD 200#\R1#.\ is the version of AutoCAD.
Displaying the Tool Palette

To display the tool palette, left-click on the Tool Palette command in the Standard toolbar or press CTRL+3.

Click the Properties button at the top of the title bar to display a menu of options.
Auto-hide
Like the Design Center and Properties windows, the Tool Palette can be set to **Auto-hide** or be hidden and exposed on demand. If **Auto-hide** is turned on, and your pointer moves outside the window, only the title bar is displayed. To activate the window, just move your pointer over the title bar.

Transparency
Another feature is **Transparency**. Increasing the Transparency allows you to keep the Tool Palette open, but see your drawing through it. The figure at the right demonstrates the effects of setting the Tool Palette Transparency to about 50%.

Customize
The **Customize** window allows you to change the order of the tabs, create groups and import and export palettes. Click or choose the **Customize** button at the bottom of the Tool Palette title bar. Right-clicking the **Palettes** pane of the **Customize** window lets you create a **New Palette** or **Import** previously exported palettes. Some of the options available when right-clicking in the Palette Groups pane are create **New Group**, and **Import** previously exported Palettes Groups.

Docking
The **Allow Docking** setting determines whether or not the palette may be docked or must remain floating.

Anchoring
Anchoring (AutoCAD 2007+) allows you to attach the palette at the left or right side of the drawing area. Allow Docking must be turned on.

View Options
Right-clicking within the palette area displays a slightly different list of choices. **View Options** allows you to control the size and content of the tools on the palette. Tools may also be sorted.
Creating a Tool Palette

A tool palette is added by clicking on the **Properties** icon at the top of the Tool Palette title bar and selecting **New Palette** from the menu. Finally, the name of the tool palette is entered.

A new, blank palette is added. If you have several tool palettes, or the Tool Palette window is small, the title tabs will appear stacked at the bottom. Click on the stacked tabs to view a list of the hidden tabs.

You may need to resize the Tool Palette window to view the titles on the tabs.

Using Copy to Add Blocks to the Tool Palette

AutoCAD 2005 made it possible to simply copy and paste blocks and other objects from a drawing to a tool palette.

You can place commands on the tool palette by clicking on an object, typing **CTRL+C**, left-click on the tool palette and typing **CTRL+V**. A big advantage to this method is that all the properties of the object will be applied to the tool in the palette. You can also use a click, drag and drop technique to copy an object to a palette.

Any tool created by copying to a tool palette will inherit the general properties of the source objects. That means the layer, color, linetype and linewidth settings of the source object will be imbedded in the tool. In addition, objects like dimensions and text will inherit style properties.

Blocks in Tool Palettes

Tool Palettes are a natural way to create a graphic based library. A block tool can be created by using a click, drag and drop technique to copy an inserted block to a palette. DesignCenter can be used to click, drag and drop a block (A) defined within an unopened drawing to a tool palette (B).
Click, drag and drop a drawing (A) from Explorer or DesignCenter to create a block tool (B) from a drawing.

The source object can be a block defined within a drawing or an entire drawing. In either case, the drawing must be retained (not deleted or renamed) or the tool will not function.

Using the CUI to Add Commands
Beginning with AutoCAD 2007 commands can be dragged to a Tool Palette. To add a command from the Click the Properties button at the bottom of the title bar. Next, choose the category that contains the desired command (A). Click, drag and drop the command (B) to the desired tool palette (C). Close the CUI window.
Grouping Tool Palettes

An effective way to manage the number of Tool Palettes available at any one time is by creating Groups. Palettes can be assigned to one or more Groups and only the Tool Palettes within a Group are displayed when the Group is active.

Making a Group

To make a Group, click or choose the **Properties** button at the top of the Tool Palette title bar. Then right-click in the Palette Groups pane and select **New Group**.

Then use a click, drag and drop technique to place Palettes (from the Palette pane) to the group.
Displaying a Group
Click or choose the Customize button at the top of the Tool Palette title bar. Click the group name to activate.

Importing and Exporting Tool Palettes
In order to protect your investment of time in creating Tool Palettes or to share your Tool Palettes with others, you will need to Export your Tool Palettes. Tool Palettes are not part of the menu and if you delete a Tool Palette, it is gone forever unless you Export it.

To Export a Tool Palette, click or choose the Customize button at the bottom of the Tool Palette title bar. Click the Tool Palette name to Export. Right-click and choose Export... from the menu.

The default file name for the XTP (eXport Tool Palette) file will be the Tool Palette name.

Consider create a folder on a shared network drive for Exported Tool Palettes. Your Tool Palettes will get backed up and will be available to your colleagues.

In addition to the XTP file, a folder named Images will be created that contains the thumbnails used by the Tool Palette.

To Import a Tool Palette, click or choose the Properties button at the bottom of the Tool Palette title bar. Right-click and choose Import... from the menu. Locate the desired XTP file.
Removing Unused Data – Purge

The Purge command removes or deletes unused layers, blocks, linetypes, text style and dimension styles from the drawing. The purge command does not delete any objects that are actually a part of your drawing.

View items

The two radio buttons at the top determine whether the window displays the items that can or cannot be purged. Typically, you would view the items the can be purged. Remember, only unused items can be purged.

Confirmation

If you check the Confirm each item to be purged, you will be asked to confirm the removal each item, no matter how many.

Nested Items

Items used in a block, even if the block is unused, cannot be purged until the block is purged. To avoid having to use the purge command repeatedly, place a check mark next to Purge nested items.

Unnamed Objects

If any zero length objects or empty text objects are present in the drawing, this option will be available. Checking this box deletes these objects, but only those not in blocks or on locked layers.

Purge a Single Item

To purge a single item, left-click on the + to expand the grouping, left-click on the item name and finally left-click on the Purge button.

Purge a Group of Items

You can purge just a group of items, for instance all the unused blocks, by left-clicking on Blocks and then left-clicking on the Purge button.

Purge All

Left-click on the Purge All button to remove all unused items.